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1 Hotfolder Prints

Overview
Hotfolder Prints is a collection of four programs for event photographers and photo booth operators:
Hotfolder Prints which monitors a hot folder for images and automatically formats and prints them,
Breeze Viewer which monitors a hot folder for images and displays them in a slideshow and Twitter
Hashtag Monitor which automatically downloads photos from Twitter.

Hotfolder Prints
Hotfolder Prints is a powerful utility for automatically laying out one or more images on to a single page
and then printing them. In addition it can save a JPEG copy of this layout and display it in a slideshow,
email it to users or email it to social networking and photo sharing web sites such as Flickr and Twitter.
Hotfolder Prints monitors a folder (the "hot folder") for new JPEG images. When enough JPEG images
have been added it automatically formats these into a single page ready for printing, emailing or other
actions. Hotfolder Prints comes with a copy of Breeze Viewer which runs a slideshow that
automatically updates as new images are added to the display folder. When used in conjunction with
our photo booth software, Hotfolder Prints provides a complete solution for displaying a rolling
slideshow of the event's photos and for emailing copies to users and uploading to social networking
sites such as Facebook.

In summary, Hotfolder Prints monitors a folder for JPEG or PNG images and then automatically lays
them out on to a single page and then:
· Optionally prints the page. For example an event shooter might be shooting tethered and want each

photo to be resized, sharpened, logos and captions added and then printed automatically. Or a
photo booth operator may want to print two copies of each set of photos using different layouts: the
photo booth could print out traditional 6x2 strips of four images and Hotfolder Prints could print out a
larger 6x4 print of four photos arranged in a 2x2 grid.

· Optionally saves a copy of the print layout and then emails it. This could be to a fixed email address
to automatically upload the picture to a site such as Facebook or Flickr or it could email the photo to
users of a photo booth who entered their email address using a touchscreen.

· Optionally saves a copy of the print layout and copies it to a different folder. This could be to your
DropBox folder so that the photos are automatically uploaded to your DropBox page where they can
be shared and viewed as a photo gallery or to a folder for automatic uploading to an album on
Facebook

Breeze Viewer
Breeze Viewer is a slideshow utility that comes with Hotfolder Prints. It monitors a folder and displays
JPEG images and animated GIFs in that folder as a slideshow, automatically adding new images to
the slideshow as as they are added to the folder. This is great for event shooting and photo booths as
you can leave the slideshow running on a large monitor or TV display and have it update automatically
as more photos are taken during the event.
More information on using Breeze Viewer.

Breeze Gallery Uploader
The Breeze Gallery Uploader is a flexible tool for automatically uploading photos, animated GIFs and
MP4s to online galleries. The HTTP upload option can upload files to gallery systems such as Photo
Booth Gallery (https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/) or
any other gallery that has suitable scripts for receiving the uploaded files.
Breeze Gallery Uploader can also upload files directly to  Hula Gallery (https://www.hula.co/apps/
gallery)).
Please note: "Photo Booth Gallery" and "Hula Gallery" are provided by other companies and require
subscriptions that must be purchased separately. Please visit their respective web sites for more
information.

https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
https://www.hula.co/apps/gallery)
https://www.hula.co/apps/gallery)


Hotfolder Prints 3

© 2022 Breeze Systems Ltd

More information about Breeze Gallery Uploader

SmugMug Uploader
The SmugMug Uploader is a tool which monitors a folder for new JPEG images, animated GIFs or
MP4 movie files and automatically uploads them to your SmugMug account
More information on uploading to SmugMug

Twitter Hashtag Monitor
The Twitter Hashtag monitor is a tool which automatically downloads photos posted on Twitter with a
particular hashtag. It works by scanning Twitter for tweets which match the search hashtag and
contain a photo. When it finds a matching tweet it downloads the photo, the author's name and profile
photo, the text of the tweet and the date of posting. This information can then be used by Hotfolder
Prints to create a page showing the Twitter photo and automatically print it or save it as a JPEG image.
The JPEG image can be displayed in a slideshow using Breeze Viewer or in kiosk software such as
Breeze Kiosk where users can view the images and print, email or text them.
More information on using the Twitter hashtag monitor
Please note that Breeze Kiosk is a separate product. Please visit the Breeze Systems' website for
more information about Breeze Kiosk.

Topics covered in this help file
Installing and registering Hotfolder Prints
General operation and set up
Automatic layout of photos
Custom layout of photos
Adding captions
Emailing images
Downloading Twitter Photos using Twitter Hashtag Monitor
Running a slideshow using Breeze Viewer
Automatically uploading images to other photo sharing sites
Tokens
How to create PNG images using Photoshop
Release history

If you are running a photo booth you may also find this series of articles on photo booth shooting useful

2 Installing, Registering and Activating Hotfolder Prints

When you install Hotfolder Prints you need to activate your license on each PC it is running on.
Activating the software is a quick and simple procedure if the PC has access to the internet, however,
we recommend activating the PC at least 48 hours before an event. You can still activate a computer
which does not have access to the internet, but this involves sending an email to sales@breezesys.
com and will take longer than activating the software online. Each license can be activated on two
computers, providing only one computer is used at once.

You must deactivate the software before making any hardware changes, upgrading or repairing
the PC, reinstalling Windows or reformatting a hard disk. The software can then be reactivated after
the work has been done.

Topics covered in this section:
· Installing the software
· Uninstalling the software
· Evaluating the software

http://www.breezesys.com/BreezeKiosk
http://www.breezesys.com/BreezeKiosk
http://www.breezesys.com/articles/photobooth.htm
mailto:sales@breezesys.com
mailto:sales@breezesys.com
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· Registering
· Activating
· Deactivating
· Moving the software to a different PC
· Making changes to your PC
· Decommissioning a PC
· Checking for updates
· Activation problems

Installing the software

The latest version of Hotfolder Prints can be downloaded from www.breezesys.com.

To install Hotfolder Prints simply download and run the setup program then follow the on-screen
instructions.

Uninstalling the software

Hotfolder Prints can be uninstalled using the standard Windows "Uninstall a program" option in the
Programs section of the Windows Control Panel.
IMPORTANT: Please deactivate Hotfolder Prints before uninstalling otherwise you may not be able to
activate the software on another computer. If you forget to deactivate the software you should be able
to reinstall the software, deactivate it and then uninstall.

Evaluation Version

The trial evaluation version of the software is identical to the registered version and is fully functional
for 15 days. Each time you run the software it will display the registration dialog allowing you to enter a
registration code or press the "Evaluate" button to continue evaluating the software:

http://www.breezesys.com/Hotfolder/index.htm
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At the end of the 15 day trial period you must purchase a license to continue using the software.

Registering the software

To purchase a license for Hotfolder Prints please visit our website: http://www.breezesys.com/
purchase_hotfolder.htm. You will be sent an email containing your registration details when your
payment has been received.

To register Hotfolder Prints run the application enter your registration name and code exactly as they
appear in your registration email. You may find it easier to copy and paste both the registration name
and code directly from your registration email to avoid mistakes when entering it. Please keep a copy
of your registration email safe in case you need to re-enter your registration details.

Click on the "Register" button after entering your name and registration details. If the details are
correct the message below will be displayed. An error message will be displayed if the name and
registration code are not valid (e.g. they were not entered correctly) or if you need to purchase an
upgrade to use this version of the software.

http://www.breezesys.com/purchase_hotfolder.htm
http://www.breezesys.com/purchase_hotfolder.htm
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Click on the "Yes" button to register the software and the following message will be displayed asking
you whether you want to activate the software on this computer:

Click on the "Yes" button to activate the software on this computer (see the section below for details).

Activating the software

The software must be activated on the computer before it can be used. The software can be run
without activating for up to 10 days after the the date when the registration code was issued. After that
time the software will not run unless it is activated. Each license can be activated on two computers,
providing only one computer is used at once. If you wish to move the software to a different computer
you must deactivate it from the old computer before activating it on the new computer. Once the
software has been activated on a computer you can run it normally.

To activate the software click on the "Activate..." button in the registration dialog

and the activation dialog below will be displayed:
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The quickest and simplest way to activate the software is to do it online by pressing the "Activate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to activate the software online.
Please note that it may take up to 30 seconds to activate the software online.

If the computer is not connected to the internet you can activate the software by email by clicking on
"Activate by email" button and the dialog below will be displayed:

It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't

mailto:sales@breezesys.com.
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have email you can copy the activation text to a USB memory stick and then read it on a computer
which does have email.

You should normally receive an email containing your activation code within 12 hours of sending the
activation request email. Paste your activation code into the "Activation code" text area at the bottom of
the activation dialog and click on the "Activate" button to activate the software. If you have closed the
activation dialog you can display it again by running the software and then clicking on the "Activate..."
button in the registration dialog followed by the "Activate by email" button.

Deactivating the software

The software can only be activated on up to two computers at any given time. If you wish to move the
software to a different computer you must deactivate it from the old computer before activating it on
the new computer.

You also need to deactivate the software before making any hardware changes, upgrading or
repairing the PC, reinstalling Windows or reformatting a hard disk. The software can then be
reactivated after the work has been done.

To deactivate the software select "Register..." from the Help menu in the main window to display the
registration dialog:

Then click on the "Deactivate..." button to display the deactivation dialog:
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The quickest and simplest way to deactivate the software is to do it online by pressing the "Deactivate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to deactivate the software online.
Please note that it may take up to 30 seconds to deactivate the software online.

If the computer is not connected to the internet you can deactivate the software by email by clicking on
"Deactivate by email" button and the warning dialog below will be displayed:

Click on the "Yes" button if you want to continue and the deactivation dialog below will be displayed:
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It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the text to a USB memory stick and then read it on a computer which does
have email.

You should normally receive an email acknowledging the deactivation code within 12 hours of sending
the request email. If you forget to copy the deactivation information and email it to sales@breezesys.
com you can display it again by selecting "Register..." from the Help menu in the main window and
clicking on the "Display" button. Please note that the copy of the deactivation information will be not be
available after another registration code has been entered.

Moving the software to a different PC

The software can be activated on up to two computers at any given time and so if you are moving the
software to a different PC you should deactivate the software from the old PC first. Then install the
software on the new PC, then register and activate the software.
If you are planning to move the software to a different PC permanently please following the instructions
for decommissioning a PC.

Making changes to your PC

You need to deactivate the software before making changes to your PC such as upgrading the PC
hardware, reformatting a hard disk, reinstalling Windows, upgrading Windows or getting a PC
repaired.

mailto:sales@breezesys.com.
mailto:sales@breezesys.com
mailto:sales@breezesys.com
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Simply deactivate the software online (or by email if the PC doesn't have access to the internet), make
the changes and then re-activate the software. If Windows has been reinstalled or the hard disk has
been replaced or reformatted you may need to re-install Hotfolder Prints, re-enter your name and
registration code and then activate the software.
The latest release and previous releases of the software can be downloaded from the upgrades page
on the Breeze Systems website.
IMPORTANT: Please make sure you have a copy of your name and registration code before making
changes to your PC just in case you need to re-enter them later

Decommissioning a PC

If you are decommissioning a PC and planning to sell it or give it to somebody else you need to 
deactivate the software and remove your registration details. It is very important that you remove your
registration details even if you have uninstalled the software otherwise the new owner may be able to
reinstall the software and gain access to your registration details. If someone obtains your registration
details they will be able to register and activate the software on their computer and could prevent you
from using it on your computer.

After deactivating the software you can remove your registration details by entering the special
registration code below:

Name: Uninstall
Code: 000JJ3-EY4BAB-9C1GBW-VMRWE8-U4V3UT-DXY5J2-YNZC4R

This will install a special old code which replaces your registration details and will cause the software
to display an "Upgrade required" message when it is run.

If you decide to use the computer again you can reinstall the software, enter your registration details
and activate software.

Checking for updates

You can check for updates by selecting "Check for updates online". This will connect to the internet
and display details of the latest version Hotfolder Prints in your web browser. Alternatively go to the
Hotfolder Prints page on our website: http://www.breezesys.com/Hotfolder

Activation problems

If the error message "The server name or address could not be resolved" is displayed when you try to
activate or deactivate the software online it means that the PC is unable to access the internet. Please
check that that the computer is connected to the internet and check your firewall settings to make sure
that Hotfolder.exe (the Hotfolder Prints program) is allowed to access the internet. If you are still
unable to activate the software online you may need to activate it by email instead.

If a different error message is displayed please follow the instructions displayed in the error message.
If you are not sure what to do please email sales@breezesys.com and include your registration name
and code and details of the error message.

Please also see the support page on the Breeze Systems website for help with activation problems.

http://www.breezesys.com/upgrades.htm#DslrRemotePro
http://www.breezesys.com/upgrades.htm#DslrRemotePro
http://www.breezesys.com/Hotfolder
mailto:sales@breezesys.com
http://www.breezesys.com/support_activation.htm
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3 General Operation and Set Up

Hotfolder Prints monitors a folder for new JPEG or PNG image files and automatically formats them
into a page and prints them. The images can be formatted using the automatic layout or custom layout
options. The automatic layout option is suitable for simple layouts where the images are arranged in a
grid. The custom layout option offers precise control over the size, position and rotation of each image
and is suitable for more complicated layouts.

To setup Hotfolder Prints click on the "File" menu and select "Preferences..." and the dialog below will
be displayed:

Select the folder to monitor by pressing the "..." browse button to the right of the text area headed
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"Folder to monitor for new images". The folder path can also include date based tokens e.g. C:
\Photobooth\%Y-%m-%D. The folder path is checked every 60 seconds and updated if it has changed.
Select the "Auto create folder" if you want Hotfolder Prints to create the folder to be monitored if it
doesn't exist.

Then specify the number of images to be used in each layout. When Hotfolder Prints is running it will
monitor the folder for new JPEG files. Once it has detected the required number of images it will
automatically format and print them.

The "Match filename (regular expression):" option normally isn't needed and can be left unchecked.
You only need to use this option if you want Hotfolder Prints to only process some of the images added
to the folder being monitored e.g. to process even numbered files and ignore odd numbered files the
regular expression should be set to .*[02468]\.JPG
Please note: an explanation of how to use regular expressions is beyond the scope of this help file.
There are many websites with more information about using regular expressions.

Select the processing mode from the "Processing mode:" dropdown list. There are three options
described below. The "Wait for XML file" option is the recommended setting if you are using Hotfolder
Prints with our photo booth software.
"Wait for
JPEGs"

Hotfolder Prints will monitor the folder for new JPEG images and will process them
when enough images are available

"Wait for
PNGs"

Hotfolder Prints will monitor the folder for new PNG images and will process them
when enough images are available

"Wait for
JPEGs or
PNGs"

Hotfolder Prints will monitor the folder for new JPEG or PNG images and will process
them when enough images are available

"Wait for
videos"

Hotfolder Prints will monitor the folder for new MP4 or MOV videos and will process
them when enough videos are available by extracting a still image from each video.
Use the "Secs into video" setting to specify where in the video the still image should be
extracted e.g. if the video has a 3 sec intro section "Secs into video" could be set to 4
seconds to skip the intro.

"Wait for XML
file"

Hotfolder Prints will monitor the folder for new XML files. Hotfolder Prints will then read
the XML file for a list of JPEG images to process. The XML file should be in the same
format as the XML summary file written by Breeze Systems' photo booth software.
This is the recommended option if you are using Hotfolder Prints with our photo booth
software.

"Wait for XML
file with
timeout"

This is the same as the "Wait for JPEGs option" except that Hotfolder Prints will wait
for an XML file with the same name as the first JPEG in the set. The JPEG images will
be processed if the timeout occurs before the XML file is found.

The delay before processing images can be set to any value from 0 to 120 seconds. Normally a value
of 1 second should be fine, but it may be necessary to use a larger delay if images take a long time to
copy to the hot folder. A longer delay may also be required to allow users time to enter their email
address when using Hotfolder Prints with the touchscreen keyboard option in our photo booth
software. Alternatively select the "Wait for XML file" processing option and Hotfolder Prints will wait
until the photo booth software has written the XML file containing the user's email address before it
starts processing the images.

Use the output dropdown list to specify how the formatted layouts should be output. The "Print only"
option will print the layout using the currently selected printer. The "JPEG copy only" option will save a
JPEG copy of the layout in a subfolder of the folder being monitored named "Prints". The "Print and
save JPEG copy" option will print the layout and save a copy in the "Prints" subfolder. When the output
is set to "Print only" or "Print and save JPEG copy" the page size is is defined by the current printer
settings. When the output is set to "JPEG copy only" a custom page size can be defined by selecting
the custom size checkbox and entering the page width and height in pixels.

An optional prefix can be added to the filenames of JPEG copies of the layout to help identify them.
The JPEG copies should be saved in a different folder from the hot folder being monitored and this
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should be specified using the "Sub folder" field. The default settings are for filenames to be prefixed by
HFP_ and to the JPEG copies to be saved in a subfolder named "prints". The filename will be the
filename prefix plus the date and time of the first image in the current set in the form
YYYYMMDD_hhmmss e.g. if the first image was taken at 20:30:05 on 12th August 2012 the filename
will be HFP_20120812_203005.jpg. This can be overridden by using tokens in the filename prefix e.g.
setting the filename prefix to %o will save the JPEG file using the same filename as the first photo in
the sequence. Please see the section on Tokens for a list of available tokens.
If there is already a filename of the same name in the folder an underscore followed by a number will
be added to the filename to prevent the existing file from being overwritten.

The "Don't process files if output file already exists" option is useful when using the File->Rescan XML
files option. When "Don't process files if output file already exists" is set Hotfolder Prints checks the
output filename and if it already exists it doesn't process the file again. If "Don't process files if output
file already exists" is set Hotfolder Prints will create a new copy of the file (with a _1 suffix) if the output
file already exists.

The "Background/overlay filename suffix" setting provides a way to select different backgrounds and
overlays for prints. This setting can use tokens to provide values that are read at run time e.g. random
numbers or data entered in the survey screens. For example to add a randomly selected overlay to a
print layout the "Background/overlay filename suffix" could be set to random{random,1,3}. The token
{random,1,3} evaluates to a random number between 1 and 3 giving a randomly generated suffix.
When preparing the print layout the software will look for an overlay named overlay_random1.png,
overlay_random2.png or overlay_random3.png depending on the random number. If it can't find an
overlay file with the filename suffix it will use the standard filename, overlay.png, instead.

The "Rotate output to match first photo" will rotate the JPEG copy of the print output to match the EXIF
orientation of the first photo added to the print layout. This option is useful for processing single photos
which may have different orientations e.g. backend processing for a virtual photo booth which receives
photos from cell phones which could be shot in portrait or landscape orientation.

An optional command can be run after saving the JPEG copy of the output by selecting the checkbox
and entering the command in the text edit area. This command could be used to automatically upload
the JPEG to a site such as Flickr or Facebook or to email a copy of the photo to the users. Please see
the section on uploading to photo sharing and social networking sites for more details.

The JPEG copy of the output can also be copied to another folder e.g. for automatic uploading to
Facebook. To use this select the "Copy JPEG output to folder:" option and enter the destination folder
in the text area. Use the dropdown list to control when the JPEG images should be copied. The
options are "Always copy", "Only copy if <chkbox1> is set" and "Only copy if <chkbox2> is set".
<chkbox1> and <chkbox2> refer to information read from the XML status file written by our photo
booth software. Please see the section on uploading to photo sharing and social networking sites for
more details.
Please note: The command run on the JPEG output and the JPEG copy options are not available
when the output setting is "Print only"

The printer can be setup by selecting "Printer Setup..." from the "File" menu in the main window.
Tip: To save having to setup the printer preferences every time Hotfolder Prints is run you can go to
the Windows Control Panel, select "Printers and Faxes" then right click on the printer to change its
preferences.

Set the number of copies of to print to the required number or to 0 for automatic. When the automatic
option is selected the number of prints is read from the XML summary file written by Breeze Sytems'
photo booth software. This allows the number of prints to be set using the photobooth software. If
Hotfolder Prints can't find the XML summary file it will print one copy.

Next define the print layout using the automatic layout option or the custom layout option.
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The images can be sharpened by selecting the "Sharpen images" checkbox and specifying a
sharpening amount in the range 0 to 100. The amount of sharpening required depends on personal
taste, the camera and the printer. A value of around 75 is a good starting point.

Use the "Print photos in:" dropdown list to select whether the photos should be printed in color, black
and white or "Auto color/B&W". The "Auto color/B&W" option will read the <bw_mode> tag in the XML
summary file written by Breeze Systems' photo booth software to determine whether to print the
photos in color, B&W or B&W (toned). This will default to color if the XML file is not found or it does not
contain a <bw_mode> tag. "Auto color/B&W" is the recommended when using Hotfolder Prints with
our photo booth software as this will ensure Hotfolder Prints processes the JPEGs with the same
color/B&W/B&W toning settings as selected in the photo booth software.

When using the auto layout option up to two captions can be added to the layout. These could be used
to personalize the prints by adding the name of the event or to include information such as the date
and time to make it easier to identify the layout for reprints. Please see the section on adding captions
for more details.
When using the custom layout option captions can be added using the print layout editor.

Example photo booth summary XML file

The sample photo booth summary XML file below was created using Breeze Systems' Webcam
Photobooth software. The XML summary files written by our other photo booth software (DSLR
Remote Pro for Windows, NKRemote and PSRemote) have a similar formats:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="1.1">
<photo_information>
  <date>2013/04/16</date>
  <time>09:16:20</time>
  <user_data>sales@breezesys.com</user_data>
  <prints>1</prints>
  <photobooth_images_folder>C:\Users\Chris\Documents\PhotoboothImages\example</
photobooth_images_folder>
  <caption1></caption1>
  <caption2></caption2>
  <bw_mode hue="200" saturation="200">2</bw_mode>
  <photos>
    <photo image="1">20130416_091620.jpg</photo>
    <photo image="2">20130416_091625.jpg</photo>
    <photo image="3">20130416_091630.jpg</photo>
    <photo image="4">20130416_091635.jpg</photo>
    <output>prints\130416_091620.jpg</output>
  </photos>
</photo_information>
</breeze_systems_photobooth>

The {user_data} used in the email command will read the value "sales@breezesys.com" from the
<user_data> tag. The auto prints option will read the value 1 from the <prints> tag. The auto color/
B&W option will read the value 2 and the attributes hue=200 and saturation from the <bw_mode> tag.
This will print the photos as B&W toned with a hue of 200 and saturation of 40 to give a monochrome
sepia look. The <bw_mode> tag can also be set to 0 for color or 1 for B&W without toning.
When the processing mode is set to "Wait for XML file" the following filenames of images to process
will be read from the XML file: 20130416_091620.jpg, 20130416_091625.jpg, 20130416_091630.jpg,
20130416_091635.jpg

Saving settings for future reference
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Settings can be saved to file for future reference by pressing the "Save..." button and reloaded by
pressing the "Load..." button. Please note that layout depends on the size of the page which is affected
by the printer settings. The current printer settings are saved to file with the other settings and
reloaded when loading the settings from file.
You can load settings from file at startup by dragging and dropping a settings file onto the Hotfolder
Prints desktop shortcut or by right clicking on the Hotfolder Prints desktop shortcut, selecting
properties and adding the pathname to settings file to the "Target" (or command line).

Hotfolder Prints can also read print layouts saved using our other photobooth products: DSLR Remote
Pro for Windows, PSRemote, Webcam Photobooth and NKRemote.

In Operation

When Hotfolder Prints is running the main window look something like the screenshot below:

The name of the folder being monitored is displayed in the window title bar (C:\Photobooth\2012-01-17
in the example above). The main part of the window shows an activity log and the current status is
summarized in the status bar at the bottom of the window.

The number of copies to print of each layout can be specified using the "Settings" menu or by typing
Ctrl+1, Ctrl+2, Ctrl+3, Ctrl+4 or Ctrl+5.
The settings menu also has an option to print images in color or black and white.
When Hotfolder Prints adds a new file it also takes a copy of the settings (number of copies and
whether to print in color or B&W) and will use these settings when the images are printed.

The queue can be emptied by selecting "Reset" from the "File" menu or by typing Ctrl+R. This will
remove all pending images from the queue including any images being prepared for printing.

Event Info
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Event information can be defined and used in filenames, captions etc. in Hotfolder Prints. The event
information is also read by the Twitter Hashtag Monitor, the SmugMug Uploader and Breeze Viewer
slideshow software.
The information is saved in the Windows registry so that it may be shared with other applications and
is read from the Windows registry before it is used so that it can use information supplied by other
applications. The "Photo Booth Event Info" dialog can be displayed by selecting "Event info..." from the
File menu):
 

The information is also saved in the Windows registry using the registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\Event Info.
Please note: Do not use the characters \ / : * ? " | < > in the event info if it is going to be used to define
filenames. Windows does not allow these characters to be used in filenames and this may prevent the
files from being saved.

Item Token Registry value

Event name {eventName} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventName

Event string 1 {eventString1} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString1

Event string 2 {eventString2} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString2

Event string 3 {eventString3} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString3

Event string 4 {eventString4} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString4

Event string 5 {eventString5} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString5

Print counter {eventPrintCount
er}

HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\PrintCounter
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Two print counters are available:
1. "Print counter" - this is a print counter shared via the Windows registry with other apps (e.g. DSLR

Remote Pro or Breeze Kiosk) and is decremented each time any app prints a photo
2. "Hotfolder Prints print counter" - this is a private print counter only used by Hotfolder Prints. The

counter is decremented each time a photo is printed.

4 Automatic Layout of Photos

The automatic layout option allows images to be automatically arranged on a page in a grid. An
optional background, header, footer and overlay can be added to the layout. Please see the print
layout editor section if you need more precise control over the layout, to rotate images or to print the
images different sizes.

To use the automatic layout option select "Preferences..." from the File menu and the dialog below will
be displayed:
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Make sure the "Custom layout" option is unchecked, then select the number of images to be used and
how they are arranged. This could be a single image on one sheet of paper (1 image, 1 row, 1
column), a passport style strip of images (e.g. 4 images, 4 rows, 1 column) as shown above, 2x2 grid
of 4 images or any other arrangement of up to 10 images arranged in a grid. Alternatively select "
Custom layout" and click on the "Settings..." button next to the checkbox to position each image
manually on the page.

Print layout

The print can have an optional background with a header and or footer image and an overlay image.
When Hotfolder Prints prepares the image for printing it looks for the following files in the image folder:

background.jpg - optional image which is centered on the page before adding the photos
header.jpg - optional image which is centered and placed at the top of the page
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footer.jpg - optional image which is centered and placed at the bottom of the page
left.jpg - optional image which is centered vertically and placed on the left of the page between the
header and footer
right.jpg - optional image which is centered vertically and placed on the right of the page between the
header and footer
middle.jpg - optional image which is centered vertically and placed between each column of images
image_overlay.png - optional image which is overlays each photo and uses transparency information
stored in the alpha channel
overlay.png - optional image which is overlays the page and uses transparency information stored in
the alpha channel

The images are then arranged in a grid which fills the printable area of the page less any space taken
up by a header or footer image. If the "Rotate image to maximize size" checkbox is selected the
images are rotated through 90 degrees if this would give a larger image. e.g. if the printable area for
the image within the grid is 80mm high and 50mm wide and the image was shot in landscape
orientation it would be rotated by 90 degrees to better fill the printable area.

If the number of images matches the number of rows the images can be repeated in each column by
selecting "Repeat images to fill empty columns". This is useful when printing strips of images on paper
from a dye sublimation printer e.g. two copies of 4x1 strips on a sheet of 8x6 paper.

If the "Crop image if required to fit the printable area" checkbox is selected the image will be cropped
to fill the printable area within the grid. e.g. if the printable area within the grid is square equal portions
of the left and right of the image will be cropped to make it square.

Some example layouts using four shots arranged in two columns of four:



Automatic Layout of Photos 21

© 2022 Breeze Systems Ltd

With left.jpg down the left border, middle.jpg placed between the columns, right.jpg down the right
border and footer.jpg at the bottom
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Same layout as the first example but with no left.jpg or right.jpg images defining the left and right
borders
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Same layout as the previous example but with no middle.jpg image placed between the columns
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Same layout as the previous example but with a 2mm border around each image

5 Print Layout Editor

The print layout editor can be displayed opening the "Preferences" dialog (File->Preferences...) and
clicking on the "Settings..." button to the right of the "Custom layout" checkbox.

The print layout editor can be used to create your own print layouts from scratch or to load and edit
print layout templates created earlier.
Please visit the templates page on our website to download a selection of free templates.

http://www.breezesys.com/Photobooth/templates.htm
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The right hand side of the window displays the print layout. Photos and captions can be edited
interactively by clicking on them using a mouse and then dragging to position, resize or rotate them.

The left hand area of the window contains controls to help with the layout and for loading and saving
settings:
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A Quick tour of the editor

This section gives a quick overview of some of the ways to edit the layout.

Click on the "Preset layouts..." button, select one of the preset layouts (e.g. "1 large, 3 small") and then
click on the "OK" button. The right hand side of the editor should show the page layout similar to the
screenshot above.

Left click the mouse on photo 2 to select it:
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The photo will be highlighted with a dashed red line to show that it has been selected. It will also have
a resize control in each corner and a dashed line in the center with a control for rotating the image.

Move the mouse over the center of the photo (a hand cursor will be displayed) and then click on hold
down the left mouse button and drag the photo to a new position and then release the left mouse
button. The keyboard cursor keys can also be used to adjust the position of the photo e.g. pressing the
left cursor key will move the photo one pixel to the left. Hold the shift key down and press one of the
cursor keys to move the photo 10 pixels in that direction.

Resize the photo by moving the mouse over one of the corners of the photo (a resize cursor will be
displayed) and then click on hold down the left mouse button and drag the corner to resize the photo
and then release the left mouse button.

Rotate the photo by moving the mouse over the control area at the end of the dashed line in the center
of the photo (a rotate cursor will be displayed) and then click on hold down the left mouse button and
move the mouse to rotate the photo and then release the left mouse button. The keyboard cursor left
and right keys can also be used to rotate the photo when the ctrl key is held down e.g. hold down the
ctrl key and press the left cursor key to rotate the photo 1/2 degree to the counter clockwise. Hold the
ctrl and shift keys down and press cursor left or right to snap the rotation to the nearest 15 degrees
and then rotate in 15 degree steps.

Select all the photos by typing Ctrl+A or by right clicking on a photo as selecting "Select all". The
selected photos will be highlighted with dashed red lines and can be dragged as a group by holding
down the left mouse button.

When a photo is selected it is also highlighted in the image position display in the top left corner of the
edit window. The size, position and rotation of the photo can be entered directly by clicking on the "..."
button for that image. Click on the dropdown list to change the photo number (or select "None" to
remove it or "QR code" set it to a QR code).

Add a caption by clicking on the "Edit captions..." button or by right clicking on a space in the print
layout and select "Add caption" and the dialog below will be displayed:
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Check the "Enable caption" checkbox if it is not already checked. Caption 1 should now be displayed
highlighted on the print layout (if it isn't visible click on the "Move to center" button). Type in the edit box
to change the caption text or click on the "..." button to the right of the "Font:" label to change the font
or to the right of the "Font color:" display to change the color. Click on the "OK" button and the font
should remain highlighted. You can drag, resize and rotate the text using the mouse just the as with a
photo.

Click on the "Undo" button a few times (or type ctrl+Z) a few times to undo the changes. Then click on
the "Redo" button (or type ctrl+Y) to redo the changes.

Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.

Printer setup and margins

It is a good idea to check the printer settings and printer margins before designing the layout or
running the photobooth setup wizard. To do this click on the "Printer Setup..." button and the "Printer
Setup" dialog will be displayed:
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Select the required printer from the dropdown list. If your printer isn't listed you may need to install the
printer drivers first (please see the Windows help files or printer manuals for information on how to do
this).

Click on the "Setup Printer..." button to select the page size, print orientation, print resolution and other
printer settings.
Note: if you want to print a double strip of three or four images and are using a dyesub printer that can
cut 4"x6" pages into two 2"x6" strips you need to select the 2x6 cut option in the printer driver.

Click on the "Portrait" or "Landscape" radio buttons to change the printer page orientation.

If the selected printer is setup with a page size of 4"x6" and a print resolution of 300 DPI or 600 DPI
(most professional dyesub printers support this) the "Center page" button will be enabled. You can
press this button to setup the margins to center the page in the printable area. This should produce
correctly centered prints with most printers.

Click on the "Test Print" button to print a page to help setup the printer margins. The test print from a
DNP DS40 printer will look something like this:
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In the enlarged view of the top margin shown below the top margin can be read off the ruler as 14
pixels:

And in the enlarged view of the bottom margin shown below the bottom margin can be read off the
ruler as 26 pixels:
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Check the top, left, right and bottom margins and enter the values in the printer setup dialog, It is worth
spending time setting up the print margins accurately as this will save time later.

Preset Layouts

The "Preset layouts..." button can be used to help design a number of different popular layouts using
three or four photos. These include a double strip of three or four photos, a single strip of three or four
photos, one large image with a row of three smaller images below and two rows of two images. Simply
select the layout you want, adjust the page margins and image spacing and then press the OK button
and the software will work out the settings for you:

Select the preset layout from the list of layouts in the top left of the window. The right side of the
window shows a preview of the selected layout. The spacing between photos and the top, left, right
and bottom margins can be adjusted using the edit boxes on the left of the window.
Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.
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Click "OK" to copy the layout to the print layout editor.

Editing Photo Positions

A photo can be added to the layout by selecting the photo number from one of the spare image
dropboxes showing "None" in the top left corner of the editor window. Alternatively a photo can be
hidden by setting its dropdown list to "None".

The size, position and rotation of the photo can be edited by left clicking on the photo to select it and
then using the mouse or keyboard cursor keys:

Move the photo by moving the mouse to the center of the photo (a hand cursor will be displayed) then
hold down the left mouse button and drag the photo to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the photo one pixel at a time. Hold
down the shift key and use the cursor keys to move the photo 10 pixels at a time.

Resize the photo by moving the mouse to one of the circular control handles in the corners (the resize
cursor will be displayed) then hold down the left mouse button and drag the corner to resize the photo.
The aspect ratio of the photo will be preserved (i.e. the ratio of the width to the height). Hold down the
shift key if to resize the photo without preserving the aspect ratio (this may result in the photos being
cropped when they are printed).

Rotate the photo by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the photo (the rotate cursor will be displayed) then hold down the left mouse button and
move the mouse to rotate the photo.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the photo in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate
the photo in 15 degree increments.

Photos are printed in the order in which they are defined and so if the second photo's position overlaps
the first photo the second photo will be printed on top of the first photo. You can change the order in
which photos are printed by right clicking on a photo and selecting "Move to back", "Move back",
"Move forward" or "Move to front".

You can also enter the photo position and angle directly by clicking on the "..." button for that photo on
the left side of the editor window and it will display the "Edit Position" dialog:
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You can also edit the position by right clicking on the photo and selecting "Edit image position..." from
the popup menu.

The left and top entries specify the distance in pixels of the photo from the left and top edges of the
page respectively. The layout in the print editor window will be updated automatically as you change
the settings. If the photo isn't visible you can press the "Move to center" button to center it on the page.

The width and height entries specify the width and height of the photo in pixels. To preserve the aspect
ratio of the photo you can enter 0 for the width or height and the software will replace this with the
correct value when you press the "OK" button.
Note: Entering a width and height with a different aspect ratio from the photos taken by the camera
(3:2) will result in the photo being cropped when it is printed.

The angle entry specifies the clockwise rotation of the photo in degrees.

Editing QR Codes

A QR code can be added to the layout by selecting "QR code" in one of the spare image dropboxes
showing "None" in the top left corner of the editor window. Alternatively the QR code can be hidden by
setting its dropdown list to "None". The size, position of the QR code can then be edited in exactly the
same way as a photo (described in the section headed "Editing Photo Positions" above).

The text encoded in the QR code can be edited by right clicking on the QR code and selecting "Edit
QR code..." from the popup menu. The "QR Code" dialog shown below will be displayed:
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Type in the text you want to be encoded in the QR code. Normally this is a URL which needs to be
prefixed with http://
The QR code display will be updated automatically as you type in the text. You can test the QR code
by pressing the "Test URL" button to open it in a web browser. You can also test the QR code by
scanning it with a cell phone.

The error correction dropdown list specifies amount of error correction encoded in the QR code. A
"Medium" setting should be suitable for most uses. You may wish to use the "Low" setting if the URL is
very long or the QR code is to be printed very small.

Note: The QR code text can also be edited by selecting File->Edit QR code from the main program
window.

Adding Logos and Pictures

Click on "Import logo..." to import a PNG or JPEG image into the print layout. Logos can be moved,
resized and rotated just like photos in the print layout.
When a logo image is imported the PNG or JPEG image is copied into the current photo booth images
folder and its filename is prefixed with "logo_". If the photo booth images folder already contains a file
with the same name you are asked whether to overwrite the file. Any copies of the logo in the print
layout will be removed from the layout and replaced by a single copy of the new logo image in the
center of the layout.
If the photo booth images folder already contains one or more PNG or JPEG images with a logo_
prefix they can be added to the print layout by right clicking on the background of the print layout and
selecting "Add logo...".
Please note: logos are added to the print layout after the optional overlay and will appear on top of the
photos and overlay.

Editing Caption Positions

Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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You can also edit the caption by right clicking on the caption and selecting "Edit caption..." from the
popup menu.

Select the caption you wish to edit using the dropdown box at the top and then check the "Enable
caption" checkbox if it is not already checked. The caption should now be displayed highlighted on the
print layout (if it isn't visible click on the "Move to center" button). Type in the edit box to change the
caption text. Captions span more than one line and can contain tokens such as such as %d for the
date and %t for the time the sequence started, {comment} for the comments entered in the main
screen and {filename} for the filename used for the JPEG copy of the print layout. Please see the 
section on tokens for a list of tokens available.

Click on the "..." button to the right of the "Font:" label to change the font, size and style or to the right
of the "Font color:" display to change the color.

Use the "Left offset" and "Top offset" entries to specify the position of the text. This is specified in
pixels from the top left corner of the page. Use the angle entry to specify the angle of the text. This is
specified as degrees rotation in a clockwise direction.

The "Maximum number of lines" and "Line word wrap length in pixels" settings can be used to control
how long captions are displayed. This is useful when using tokens such as {caption} for Twitter posts
where the caption text could be longer than would fit on a single line. The "Line word wrap length in
pixels" setting specifies the maximum length of a line of text (in pixels) before it is word wrapped to
start a new line of text. The "Maximum number of lines" setting specifies the maximum number of lines
that are displayed. This is useful for preventing very long captions from running off the bottom of the
page or into other elements on the page. When these options are used the maximum extent of the text
is shown by a dashed line.
Please see the Downloading Twitter photos using Hashtag Monitor for an example of how to use these
settings.

Normally text is left justified (the "Alignment" dropdown list is set to "Left justified") and its position on
the screen is measured from the top left corner of the text area.
If the "Alignment" dropdown list is set to "Centered" the text will be center justified and the position will
be measured from the top center of the text area.
If the "Alignment" dropdown list is set to "Right justified" the text will be right justified and the position
will be measured from the right side of the text area.
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Click on the "OK" button to the save the changes. The caption will be selected in the print layout:

The size, position and rotation of the can then be edited using the mouse or keyboard cursor keys
similar to moving and resizing photos.

Move the caption by moving the mouse to the center of the caption (a hand cursor will be displayed)
then hold down the left mouse button and drag the caption to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the caption one pixel at a time. Hold
down the shift key and use the cursor keys to move the caption 10 pixels at a time.

Resize the caption by moving the mouse to one of the circular control handles in the corners (the
resize cursor will be displayed) then hold down the left mouse button and drag the corner to resize the
caption.
Alternatively hold down the ctrl key and use the up and and down cursor keys to resize the caption.

Rotate the caption by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the caption (the rotate cursor will be displayed) then hold down the left mouse button
and move the mouse to rotate the caption.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the caption in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate
the caption in 15 degree increments.

Aligning, sizing and moving multiple items

All the currently defined photos, captions and QR codes can be selected by typing ctrl+A (or by right
clicking and selecting "Select all"). Alternatively just photos can be selected by typing Ctrl+P (or by
right clicking and selecting "Select all photos"). You can refine the selection by holding down the ctrl
key and clicking on the item to be added or removed from the selection.
Tip: All captions can be selected by typing Ctrl+P to select all photos followed by Ctrl+I to invert the
selection (this will unselect all photos and select all captions).

A group of selected images can be moved by holding down the left mouse button and dragging them
to the new position or by using the keyboard cursor keys.

There are various options for aligning a group of selected items e.g. left align so that a group of
images are arranged in a column. To align the currently selected elements right click the mouse on the
reference element and select the required alignment from the "Alignment" menu of the popup menu.
The selected elements will be moved to align them with the reference element.
Note: If this doesn't produce the required result simply type ctrl+Z to undo the changes.

A group of photos can be spaced evenly by selecting them in order and then right click on any of the
selected images and select "Space photos evenly". The order in which the photos are selected is
important because the middle photos will be spaced evenly between the positions of the first and last
photos in the selection. To select the photos in the right order simply left click on the first photo and
then add the remaining photos to the selection in order by holding down the ctrl key and clicking on
them.

A group of photos can be set to the same size and angle as a reference photo by selecting them and
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then right clicking on the reference photo and selecting "Make photos same size and angle".

Background Color and background.jpg

Normally the page background is white but it can be set to any color by clicking on the "..." button next
to the colored square besides the "Show background color" checkbox.

A JPEG image named background.jpg can also be used as a background. This is useful for adding
logos or fancy captions to the print or to add frames around the photos. Ideally the background.jpg
should be the same size in pixels as the printed output (e.g. 1844 x 1240 pixels for a 6"x4" print from a
DNP DS40 printer). The background.jpg will be centered on the page and so if it is bigger the excess
will be cropped from the top, left, right and bottom or if it is smaller it won't fill the page.
Tip: Set the background color to the same color as the edges of the background.jpg to avoid white
strips on the edges of the page if the background.jpg doesn't fill it.

The background.jpg should be saved in your photobooth images folder (this is displayed in the title bar
of the print layout editor window). You can copy a JPEG image into your photobooth images folder by
clicking on the "Import background..." button or by dragging and dropping a JPEG file into the print
layout editor window.

To delete a background.jpg image first press the "OK" button to save the print layout and close the
print layout editor window. Then delete the background.jpg from your photobooth images folder.

Note: If the positions of photos and captions don't quite line up with an imported background.jpg they
can be moved by typing ctrl+A (to select all) and then pressing the cursor keys.

Headers and footers

For backwards compatibility with previous releases the print layout can also display a header image
named header.jpg at the top of the page and a footer image named footer.jpg at the bottom of the
page. It is recommended that you avoid using headers and footers and use the background.jpg
instead. This will make it easier save layouts for future reference without them being specific to a
particular printer model.

Overlay

An option overlay can be placed over the photos by placing an PNG image named overlay.png in your
photobooth images folder. You can copy a  PNG image into your photobooth images folder by clicking
on the "Import overlay..." button or by dragging and dropping a PNG file into the print layout editor
window.

The overlay.png should be saved as a 24-bit color PNG file with an 8-bit alpha channel containing
transparency information.

To delete an overlay.png image first press the "OK" button to save the print layout and close the print
layout editor window. Then delete the overlay.png from your photobooth images folder.

Please see the section headed "How to create PNG images using Photoshop" for notes on how to
create an overlay.png file.

There is an example PNG file named example_overlay.png in the installation folder which can be used
for testing.
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Tip: The current layout can be saved as a JPEG file by holding down the Shift and Ctrl keys and then
clicking on the "Print Test Page" button. This JPEG image can then be loaded into a photo editor such
as Photoshop to add logos, captions etc. and then saved as a background.jpg or overlay.png image
which can be imported into the layout.

Auto selection of background and overlay images using image
orientation

The orientation of the first photo in the layout can be used to automatically select a different
background or overlay image. This is useful if you are shooting tethered and want to be able to use the
camera in portrait and landscape orientations and have Hotfolder Prints automatically apply a
background to match the camera orientation. To use this option simply append the orientation angle to
the name of the background.jpg and overlay.png files e.g. background_90.jpg and background_270.
jpg for portrait orientations and background_0.jpg for landscape orientation. Hotfolder Prints will default
to the normal background,jpg and overlay.png files if the orientation specific file isn't found.

Example: Hotfolder Prints is monitoring the download folder when shooting tethered with DSLR
camera and the photobooth images folder contains the following files:
background.jpg
background_90.jpg
background_270.jpg
overlay.png
overlay_90.jpng
overlay_270.png

A photo is taken with the camera in normal landscape orientation. Hotfolder Prints looks for
background_0.jpg first, can't find it and uses background.jpg instead. Similarly, it looks for overlay_0.
png, can't find it and uses overlay.png.
A photo is taken with the camera rotated 90 degrees counter-clockwise (in portrait orientation).
Hotfolder Prints looks for background_270.jpg first, finds it, and uses it for the background. Similarly, it
looks for overlay_270.png and uses it for the overlay.
A photo is taken with the camera rotated 90 degrees clockwise (in portrait orientation the other way).
Hotfolder Prints looks for background_90.jpg first, finds it, and uses it for the background. Similarly, it
looks for overlay_90.png and uses it for the overlay.

Please note:
1. If you are also using the background/overlay suffix for selecting backgrounds and overlays the

suffix comes after the orientation e.g. background_90_suffix.jpg
2. If you are shooting tethered using our DSLR Remote Pro for Windows please select "Use

Orientation sensor" setting from the View menu in DSLR Remote Pro to ensure the orientation
information is stored in the EXIF data of the photo.

Hiding and showing elements

Use the various "Show" checkboxes to control what is displayed in the print layout preview. This is
useful if you want to simplify the preview display to make it easier to adjust the photo positions.
Please note: Unchecking the "Show" checkbox for an element only affects the print layout preview
and does not affect the final prints.

Undo and Redo

Most actions can be undone by clicking on the "Undo" button or by typing ctrl+Z and redone by clicking
on the "Redo" button or typing ctrl+Y.
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You can't undo the "Printer setup", "Import background...", "Import overlay..." or "Import layout..."
actions.

Exporting and importing layouts

You can save a print layout for future reference by clicking on the "Export layout..." button. This will
save the entire layout including any overlay and background images to a single file with a .pblt file
extension.

A previously saved layout can be imported by clicking on the "Import layout..." button or by dragging
and dropping a print layout template file into the print layout editor window. 
It should be possible to import layouts defined for any similar printer (i.e. one with the same page size
and print resolution) provided the print margins were set accurately.
Please note: If your photobooth images folder contains a background.jpg or overlay.png image they
will be deleted or overwritten when importing a print layout.

Please visit the templates page on our website to download a selection of free templates.

6 Adding Captions

When using the automatic print layout option up to eight captions can be added to the print layout in
the print layout editor or by clicking the "captions" button in the preferences dialog. If you are using the
custom layout option it is simpler to use the print layout editor to edit the captions.

Select the caption you wish to edit using the dropdown box at the top and then check the "Enable
caption" checkbox if it is not already checked. Captions may span more than one line and can contain
tokens such as such as %d for the date and %t for the time the sequence started, {comment} for the
comments entered in the main screen and {filename} for the filename used for the JPEG copy of the
print layout. Please see the section on tokens for a list of tokens available.

Click on the "..." button to the right of the "Font:" label to change the font, size and style or to the right

http://www.breezesys.com/Photobooth/templates.htm
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of the "Font color:" display to change the color.

Use the "Left offset" and "Top offset" entries to specify the position of the text. This is specified in
pixels from the top left corner of the page. Use the angle entry to specify the angle of the text. This is
specified as degrees rotation in a clockwise direction.

The "Maximum number of lines" and "Line word wrap length in pixels" settings can be used to control
how long captions are displayed. This is useful when using tokens such as {caption} for Twitter posts
where the caption text could be longer than would fit on a single line. The "Line word wrap length in
pixels" setting specifies the maximum length of a line of text (in pixels) before it is word wrapped to
start a new line of text. The "Maximum number of lines" setting specifies the maximum number of lines
that are displayed. This is useful for preventing very long captions from running off the bottom of the
page or into other elements on the page. When these options are used the maximum extent of the text
is shown by a dashed line.
Please see the Downloading Twitter photos using Hashtag Monitor for an example of how to use these
settings.

Normally text is left justified and its position on the screen is measured from the top left corner of the
text. If the "Center justify" checkbox is selected multiple lines of text will be center justified and the
position will be measured from the top center of the text.

7 Emailing Images

When the output option is set to "Print and JPEG copy" or "JPEG copy only" an optional command can
be run on the JPEG copy of the layout:
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This command is normally used to send an email using the email_image.exe utility included with
Hotfolder Prints. Click on the "Edit email settings..." button to display the email settings dialog:
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To send an email you need to specify at least the originator's email address (the "From:" field), the
recipient's email address (the "To:" field") and the host name of your email server. Most email servers
also require a username and a password to prevent unauthorized users from sending spam emails.
For additional security select the "Use SSL for secure email" option to send the email using SSL. The
port number should normally be set to 587 when using SSL secure email or 25 otherwise (please
check the port numbers used by your ISP). Google's free GMail service is a convenient way to send
emails and can be set up using the settings shown above and replacing myname@gmail.com with
your GMail email address and entering your password.

The subject and message fields can include any of the standard tokens (e.g. %d for the date). The
special token {pathname} is be used as a placeholder for the path of the JPEG layout image to be
uploaded and is automatically added to the command line by the email settings dialog.

In normal operation no window will be displayed when an email is set. Select the "Display debug
window when sending email" if you want to display a window showing information about the sending of
the email for debug purposes. If the sending of the email fails for any reason a window containing an
error message is displayed for a few seconds. If the internet connection is unreliable the "Retries"
setting can be used to set the number of times it attempts to send the email.

Once the email server settings have been entered a test email can be sent by pressing the "Send test
email" button. This will call email_images.exe in debug mode and send a short test email and image to
test the connection and settings.
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The screenshot above shows typical settings for uploading images to Flickr using Google's gmail mail
servers.

The email_image.exe command line email utility has the following options:
-d               display debug window when sending email
-o<originator>   the originator's email address
-r<recipient>    the recipient's email address (where the email is sent to)
-s<subject>      optional subject line
-b<body>         optional message body (plain text)
-H<body>         optional message body (HTML format)
-h<host>:<port>  hostname of email server and optional port number
-u<username>     username of account on email server
-p<password>     password of account on email server
-S               send email as a secure email using SSL

Hotfolder Prints will read user data stored in the XML saved by our photobooth software and make this
available in the {user_data} token. This allows users to enter their email address using the
touchscreen keyboard option in the photobooth and for Hotfolder Prints to format the images for
emailing and then send them to the user's email address:

Multiple user email addresses can be processed by setting the "To:" address to {user_data_emails}.
When the {user_data_emails} token is used all the user data tokens (i.e. {user_data} and {user2_data}
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through {user9_data}) are scanned for correctly formed email addresses and the command is run for
each with the email address passed in the {user_data_emails} token. Email addresses must not
contain spaces and should start with one or more characters followed by @ and one or more
characters followed by . and one or more characters e.g. name@domain.com

Users' email addresses can be saved to a CSV log file for future reference by selecting "Log email
addresses to file" and specifying the name and location of the log file. The information is stored in the
following format:
<date>,<time>,<email>,<image>,<status>
Where <date> is the date in the form YYYYMMDD, <time> is the time in the form hhmmss, <email> is
the user's email address and <status> is "sent" if the email was sent successfully or "fail" if there was
an error.

Plain text and HTML format emails

Emails can be sent as plain text only with the image file sent as an attachment or as HTML format
emails with the image file embedded in the email. Images can be embedded in an HTML format email
by using the <img> tag e.g. <img src="{image}">. When the email is sent the token {image} is replaced
with the URL for the embedded image. Multiple images can be embedded in the email by adding their
pathnames to the end of the email command (after {filename}) and accessed in the email using the
tokens {image2} for the second image, {image3} for the third image etc.

Logging email failures and sending emails after an event

If the internet connection at an event is unreliable or not available Hotfolder Prints may not be able to
send the emails during the event but can save a batch file which can be run later when a reliable
internet connection is available to send the emails. To enable the writing of the failed emails batch file
select the "Log email addresses to file" option and specify the name of the log file. In additional to
writing the log file, the commands to send any failed emails will be written to a separate log file which
has the same name as the main log file but with _failed.log appended e.g. in the screenshot above the
main log file is C:\Users\Chris\Documents\email_log.csv and the failed emails log file would be named
C:\Users\Chris\Documents\email_log_failed.log. To send the failed emails simply rename the log file to
give it a .bat file extension, e.g. C:\Users\Chris\Documents\email_log_failed.bat, and then run the
batch file by double clicking on it in Windows Explorer.

XML file containing user data

Hotfolder reads the email address from an XML file in the folder being monitored and with the same
name as the first photo e.g. if you are running a photobooth which takes sets of four photos saved a
folder named D:\Photobooth\20121210 with the following filenames:
D:\Photobooth\20121210\IMG_0001.JPG
D:\Photobooth\20121210\IMG_0002.JPG
D:\Photobooth\20121210\IMG_0003.JPG
D:\Photobooth\20121210\IMG_0004.JPG
Hotfolder prints will look for an XML file named D:\Photobooth\20121210\IMG_0001.XML. The
touchscreen keyboard option in Breeze Systems' photobooth software will automatically save the
information entered by the user to the XML file to be picked up by Hotfolder Prints when it processes
the images. If the photobooth software is setup to display the touchscreen keyboard after taking the
photos you need to make sure Hotfolder Prints doesn't process the images before users have had
time to enter their email address. There are two ways to do this:

1. Set the "Delay before processing images:" to a long enough time to allow users to enter their details
e.g. 60 secs

2. Select the "Wait for XML file before processing images" option so that Hotfolder Prints won't
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process the images until the XML file has been written and the user data is available

Option 2 is the recommended method to use because it will start processing the images as soon as
the XML file is written whereas option always waits for a "safe" amount of time which may cause a
delay. However, if you use the "Wait for XML file" option you do  need to make sure that the XML file is
written otherwise Hotfolder Prints will keep waiting for the XML file and will stop processing new
images. You can avoid this problem by setting a suitable timeout e.g. 120 secs before Hotfolder Prints
gives up waiting for the XML file.

Recommended settings: Select "Wait for XML file before processing images" and set a suitable
timeout of 120 secs (or more) just in case the XML file isn't written.

Note: Hotfolder Prints looks for the XML file in the same folder as the JPEG images but it can't find the
XML file it looks in the parent folder. This is useful when using green screen with Breeze Systems'
photo booth software because the XML file and the unmodified JPEG images from the camera are
saved in the same folder and a green screened copy of the photos is saved in a subfolder named
green screen e.g.

D:\Photobooth\20121210\IMG_0001.JPG - unmodified photo 1 downloaded from the camera showing
the green background
D:\Photobooth\20121210\IMG_0002.JPG - unmodified photo 2 downloaded from the camera showing
the green background
D:\Photobooth\20121210\IMG_0003.JPG - unmodified photo 3 downloaded from the camera showing
the green background
D:\Photobooth\20121210\IMG_0004.JPG - unmodified photo 4 downloaded from the camera showing
the green background
D:\Photobooth\20121210\IMG_0004.XML - XML file containing information entered by the user with
the photo booth software's touchscreen keyboard
D:\Photobooth\20121210\greenscreen\IMG_0001.JPG - green screened copy of photo 1 with the
green background replaced with the green screen background image
D:\Photobooth\20121210\greenscreen\IMG_0002.JPG - green screened copy of photo 2 with the
green background replaced with the green screen background image
D:\Photobooth\20121210\greenscreen\IMG_0003.JPG - green screened copy of photo 3 with the
green background replaced with the green screen background image
D:\Photobooth\20121210\greenscreen\IMG_0004.JPG - green screened copy of photo 4 with the
green background replaced with the green screen background image

With this setup you want to Hotfolder Prints to monitor the D:\Photobooth\20121210\greenscreen
folder so that it processes the green screened images not the original photos from the camera which
show the green background. Hotfolder Prints will still find the XML file because it looks for the XML file
in the D:\Photobooth\20121210\greenscreen folder first and then tries the parent folder D:
\Photobooth\20121210

8 Running a slideshow using Breeze Viewer

Breeze Viewer is a standalone program for monitoring the contents of a folder and displaying JPEG
images or animated GIFs in a slideshow. New images added to the folder are automatically added to
the slideshow after a preset "stable time". Breeze Viewer displays the images as a full screen
slideshow with a black background and an optional caption showing the image filename. It can be
setup to display the newest image only or to run a slideshow of all the images in the folder being
monitored.

The following dialog is displayed when Breeze Viewer is run:
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First select the folder to be monitored for images. When new images are found in the folder being
monitored they are added to the slideshow and images deleted from the folder are removed from the
slideshow. If the "Scan subfolders for images" option is selected BreezeViewer will also scan
subfolders for images to include in the slideshow.
Tokens for the date can be used when specifying the folder to be monitored for images e.g. C:
\Users\Chris\Documents\PhotoboothImages\%Y-%m-%D. Please see the section on tokens for details
of date based tokens.

Select the "Auto run slideshow on startup" if you would like the slideshow to start automatically when
Breeze Viewer is run.

The normal way to exit the slideshow is to press the escape key on the keyboard, but this can be a
problem if the slideshow is running on a tablet PC which doesn't have a keyboard. If this is a problem,
you can select the "Double click to exit" option to exit the slideshow by double clicking in the bottom
right corner of the screen. Enter a password in the "password:" edit box to prevent users from being
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able to exit the slideshow. When a password is defined a touchscreen keyboard asking for the
password will be displayed when double clicking in the bottom right corner of the screen.

The "stable time" is the number of seconds the file size must stay the same before the image is
displayed by Breeze Viewer. This can be set to a low value such as 2 seconds if the images are simply
being copied into the folder from another folder on the disk. A longer value is useful if the images are
being transferred by FTP from a remote computer where network delays may cause the transfer to
pause for several seconds. This will prevent Breeze Viewer from trying to display an image which has
only been partially transferred from the remote computer.

The transition between images can be set to one of the following:
"None" - images are displayed instantly
"Vertical slide" - the next image slides down from the top of the screen and pushes the current image
off the bottom
"Diagonal slide" - the next image slides down from the top, right of the screen and pushes the current
image off the bottom, left
"Horizontal slide" - the next image slides down from the right of the screen and pushes the current
image off the left
"Fade to black" - the current image fades to black then the screen fades from black to the next image
"Dissolve" - the current image dissolves into the next image
"Flip" - the screen flips like turning a playing card to hide the current image and reveal the next image
"Cube" - the screen rotates like a cube to hide the current image and reveal the next image
"Random slides" - randomly uses a vertical, horizontal or diagonal slide for each transition
"Random " - randomly uses one of the above transitions
"Mosaic" - displays a mosaic of images on the screen using the specified number of rows and columns
"Mosaic with fade" - same as mosaic, uses fade to black when switching images
"Mosaic with dissolve" - same as mosaic, uses dissolve when switching images
"Mosaic with zoom" - same as mosaic, but displays each image full screen first then zooms it down to
its mosaic display position
"Mosaic with zoom + bg fade" - same as ""mosaic with zoom", but fades the mosaic background when
displaying the zoomed image. The "Background fade" setting specifies the amount by which the
background is faded (0=no fade, 255=fade to black)
"Mosaic with flip" - same as mosaic, but when updating an image the old image is flipped out and the
new image flipped in

Please note: some graphics cards my have limited support for the graphics acceleration required for
some of the slideshow transitions and the slideshow may run very slow. Please use the "None" or
"Mosaic" slideshow transitions if you experience performance problems.

The background color used for the slideshow can be changed by clicking on the "..." button to the right
of the "Background color:" display.
The slideshow can be displayed on an optional JPEG background image by entering the full pathname
of image in the "Optional background image:" text box or by clicking on the "..." button and selecting
the background file. When the slideshow runs the background image will be resized to fit the screen. If
the background image doesn't have the same aspect ratio as the screen the background color will be
visible above and below or to the left and right of the background image.

When one of the mosaic layout transitions is selected the "Mosaic layout settings" can be used to
adjust the layout. Use the "Rows" and "Columns" settings to specify the number of rows and columns
of photos to show. When the "Random tiling" option is selected the photos are updated in random
positions on the display. When it is not selected the photos are placed in order from the left to right and
top to bottom. The horizontal and vertical spacing options allow the spacing between photos to be
adjusted. When using the mosaic with zoom options the "Full screen display time (ms):" setting
specifies how long the zoomed image is displayed on the screen before it is displayed in the mosaic e.
g. set this to 2000 to display the full size image for 2 seconds.

Images can be cropped before they are displayed by selecting the "Crop image" checkbox and
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specifying the crop area using the "left", "top", "width" and "height" settings. This option is useful if you
are running a slideshow of photos from a photo booth setup to print double strips of 4. You can use the
crop option to crop the double strip of 4 into a single strip for display and then maybe use the mosaic
display option to display several strips at a time. For example suppose the photo booth is printing
double strips of 4 photos on 6"x4" paper @ 300 dpi. The print layout will be 1228 x 1864 pixels in size,
including the printer margins, and this can be cropped into a single strip by setting left=14, top=16,
width=600 and height=1800.

The "Max percentage upscaling" setting controls the amount by which images can be scaled up to fill
the screen. This setting is useful when displaying animated GIF files which may be too small if
displayed at their normal size. The default setting is 100% which means that images are not scaled up
beyond their normal size. It is recommended that this setting is not set to more than 300% otherwise
the images may appear pixellated.

Select "Sharpen image" and the sharpening amount to sharpen the displayed images. This uses the
same HQ sharpening method as BreezeBrowser Pro. The default setting is 75.

Select "Enable slideshow" and a suitable interval to display all the images in the folder in a continuous
loop. The interval in seconds can be specified in the "Interval (secs):" text box. Use a negative value to
specify the interval in milliseconds e.g. -200 to display a slide every 200ms (or 5 slides per second).
Please note that minimum slideshow interval may be limited by the speed of the computer.

Select "Show caption" to display the full pathname of each image in the top left corner of the screen.
Click on the "Caption settings..." button to specify the caption text, font, color and placement:

The caption text can use the following tokens to display information about the currently displayed
image:
{pathname} - the full pathname of the image including drive letter, folder and filename e.g. C:
\photobooth\2012-12-16\IMG_0001.JPG
{dir} - the pathname of the folder being monitored for images e.g. C:\photobooth\2012-12-16
{file} - the filename of the image including the file extension e.g. IMG_0001.JPG
{fileNoExt} - the filename of the image without the file extension e.g. IMG_0001
{time} - the file creation time of the image in 12 hour format e.g. 9:45:07
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{time24} - the file creation time of the image in 24 hour format e.g. 21:45:07
%a to %z - various formatting codes to display the date and time using the file creation time (Google
strftime for details) e.g. %a gives the abbreviated weekday name
{left,n,str} - Extracts the first n characters from str (which can be a string or token) e.g. {left,4,{file}}
gives the first 4 characters of the filename
{mid,n,m,str} - Extracts m characters starting from the n'th character from str (which can be a string or
token) e.g. {mid,1,2,{file}} gives the 2nd and 3rd characters of the filename
{right,n,str} - Extracts the last n characters from str (which can be a string or token) e.g.
{right,4,{fileNoExt}} gives the last 4 characters of the filename

Click on the "..." button to the right of the font display to select the font type, size and style. Then click
on "..." buttons to the right of the foreground and background colors to select the colors.

Use the alignment dropdown list to select the text alignment (left justified, centered or right justified).
Then define the placement of the text using the left and top offset values.

When captions are not selected the image is displayed on a plain black background.

Select "Show titles/ads" to display title pages or adverts every few images during the slideshow. Click
on the "Titles/Ads settings..." button to display the titles/ads settings page:

The title pages/adverts need to be in a different folder to the folder that is being monitored for
slideshow images and can be selected by clicking on the "..." browse button on the right. The
frequency with which the titles/ads are displayed is set using the "Number of images to display
between titles/ads" field. When the slideshow is started it scans the folder containing titles/ad JPEG
images and sorts them so that they are displayed in alphabetical order.

Select "Display images in random order" to display each image in a random order. To ensure each
image is displayed this works in a similar way to shuffling a deck of cards then dealing each card in
turn before shuffling again and repeating the process. You can also select the option to "Display new
files next" when "Display images in random order" is selected. This will ensure that new files added to
the folder are displayed as the next image rather than in random order.

Normally images are automatically rotated using the rotation value read from the EXIF Orientation tag
in the image shooting data. Uncheck the "Auto rotate JPEGs using EXIF Oirentation data" option to
display images without rotation.

Press the "Run" button to start the viewer using the current settings. On a dual monitor system drag
the settings dialog to the monitor you wish to display the images on before pressing the "Run" button. If
the "Auto run" option is selected Breeze Viewer will automatically start running the slideshow using the
saved settings when it starts up.
Press the "Esc" key to exit the slideshow and return to the settings dialog.
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Using Hotfolder Prints to prepare images for Breeze Viewer

A popular use for Breeze Viewer is to display a slideshow of images taken in a photo booth at an
event. The simplest way to do this would be to set up the photo booth to make a JPEG copy of the
print layout and for Breeze Viewer to display these JPEGs. However, this is something of a
compromise because the JPEG copy of the print layout from the photo booth is optimized for printing
not for display on a monitor. An alternative option would be to use Hotfolder Prints to create a layout
which is optimized for screen display and to display these images in the slideshow. This can be done
as follows: first check the resolution of the screen displaying the images, e.g. a 1080p HDTV display
has a resolution of 1920x1080 pixels. Then set up Hotfolder Prints to monitor the folder where the
photo booth images are saved, and to lay them out on a screen sized page and save them in a
subfolder named "slideshow" for Breeze Viewer to display:

Hotfolder Prints settings for creating a layout for a slideshow. The output option is set to "JPEG only"
and a custom size of 1920x1080 pixels is used to match the screen size of the monitor displaying the
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slideshow. The subfolder is set to "slideshow" so that the JPEG layout images are saved in a separate
folder.

The Breeze Viewer settings to display the slideshow would look something like:

Breeze Viewer slideshow settings to display images saved in the slideshow subfolder by Hotfolder
Prints. Note that image sharpening is disabled because the images have already been sharpened by
Hotfolder Prints

The images formatted for the slideshow would look something like this:
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Whereas the JPEG copy of the print layout saved by the photo booth software would look more like
this:
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9 Downloading Twitter Photos

Hotfolder Prints comes with a Twitter hashtag monitor program. The program works by logging into
Twitter and searching tweets that match a particular hashtag. When a matching post or tweet is found
the photo is downloaded to the PC together with the profile picture and an XML summary file
containing information such as the username, date and time of the post or tweet and the caption. This
information can then be processed automatically by Hotfolder Prints to create a page showing the
Twitter posting which can be printed automatically or saved as a JPEG image for viewing in a
slideshow using Breeze Viewer or in kiosk software (such as our Breeze Kiosk software) for printing,
emailing or texting.
The combination of the Twitter hashtag monitor and Hotfolder Prints provides a fully automated Twitter
hashtag printing system. An interactive system which downloads and displays the photos and lets the
user choose which photos to print, email or text can be created by adding our Breeze Kiosk software.
Please note: Breeze Kiosk is a separate product which can be purchased from our website: www.
breezesys.com/BreezeKiosk

Running the Twitter Hashtag Monitor

http://www.breezesys.com/BreezeKiosk
http://www.breezesys.com/BreezeKiosk
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Double click on the Twitter Hashtag Monitor program icon on the Windows desktop to display the
program settings:

You can either enter your Twitter username and password here or enter them later when the Twitter
login screen is displayed. If you enter them here they will be saved with the other settings and loaded
the next time Twitter Hashtag Monitor is run. Leave the "Twitter username:" and "Twitter password:"
fields empty If you do not wish your Twitter username and password to be saved.

Enter the hashtag to monitor in the "Hashtag:" field (the hashtag can be specified with or without the
#).

Enter the location where the photos should be saved in the "Download folder:" field. This can include
tokens for the hashtag or date e.g. to download photos into a folder named using the today's date and
the hashtag you could set it to something like:
D:\Twitter\%d_{hashtag}
Please see the section on tokens for a list of date related tokens.

Set the maximum age in hours for downloaded photos. Only photos with a creation time less than this
value will be downloaded.
If the maximum age is set to 0 all the "recent and popular" photos with the hashtag will be downloaded.
Please note that the Twitter search API will only tweets that are "recent and popular" over the last 24
hours or so and may not return all tweets using the given hashtag. Once it has downloaded all the old
tweets returned by the Twitter's search API the hashtag monitor will check for new tweets using hte
"Polling interval (sec):".

Many tweets on Twitter are re-tweets and this can result in the same photo being downloaded multiple
times. Set "Ignore re-tweets" to avoid this.

Press the "Log in" button to start the download process. This will open a window with the Twitter login
screen:
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Enter your Twitter username and password if you haven't already done so and click on the "Sign in"
button to login to Twitter and authorise the PhotoHashtagMonitor to download tweets using your
account. After logging in the Twitter Hashtag Monitor will start scanning Twitter for tweets containing
the search hashtag and a photo:
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Click on the "Exit" button or the window's close button to exit Twitter Hashtag Monitor.

What is downloaded

When the Twitter Hashtag Monitor finds a tweet that matches the hashtag, contains a photo and
matches maximum age and re-tweet settings it downloads the photo to the download folder and also
the author's profile picture to a subfolder named profile_picture if it hasn't already been downloaded.
Twitter hashtag monitor also creates an XML file in the download folder with the information about the
posting. The photo is given the same filename as the Twitter tweet id and the profile picture is named
using the user id. The XML information file is given the same filename as the photo (but with a .xml file
extension).
e.g. the posting 647453302949746688_2783113695 downloaded to D:\Twitter would result in the
following three files being created:
D:\Twitter\647453302949746688_2783113695.jpg
D:\Twitter\647453302949746688_2783113695.xml
D:\Twitter\profile_picture\2783113695.jpg
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The XML information file has the following format:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="2.0">

<twitter_photo_information>
<time_t>1443199799</time_t>
<date>2015/09/25</date>
<time>17:49:59</time>
<created_at>Fri Sep 25 16:49:59 +0000 2015</created_at>
<photo>647453302949746688_2783173695.jpg</photo>
<caption>The tweet text</caption>
<user_id>2783113695</user_id>
<post_id>647453302949746688</post_id>
<username>jdoe123</username>
<full_name>John Doe</full_name>
<hashtag>photobooth</hashtag>
<profile_picture>profile_picture/2783173695.jpeg</profile_picture>

</twitter_photo_information>
</breeze_systems_photobooth>

Using Hotfolder Prints to format the photos

Hotfolder Prints can be setup to automatically format the photos downloaded by the Twitter hashtag
monitors. The layout can be printed automatically or saved as a JPEG image for displaying in a
slideshow or touchscreen kiosk.

Suggested Hotflolder Print settings for processing Twitter tweets are shown below:
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The "Folder to monitor for new images:" should be set to the folder where the Twitter Hashtag Monitor
downloads the photos.

The number of images should be set to 2 to allow print layouts with both the photo and the author's
profile picture.

The "Processing mode:" must be set to "Wait for XML file" so that Hotfolder Prints can read the
posting information.

The "Filename prefix:" should be set to a value which gives unique filenames for the JPEG copy of the
printed output e.g. %d_%t_{user_id} which uses the date, time and user id to name the file.

It is recommended that the "Don't process files if output file already exists" option is selected. This will
allow the File->Rescan XML files option to be used without duplicate copies of the output files being
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created. This is useful if Hotfolder Prints is run after Hashtag Monitor has downloaded the images.

Next select the "Custom layout" option and click on the "Settings..." button to create the print layout.
The settings below show a layout for 6x4 prints made using a 300dpi dyesub printer:

When designing a Twitter print layout image 1 represents the photo and image 2 represents the
author's profile picture. The layout above also includes a QR code which can be scanned by a smart
phone to access a web page (this is covered in more detail latter).

Two captions are defined in the layout above. The first caption uses the {username}, {date} and {time}
tokens to print the author's username and that date and time the photo was posted. The tokens are
replaced with values for the photo being processed. The second caption uses the {caption} token to
display the photo's caption. Captions can be long and so the "Line word wrap" and "Maximum number
of lines" settings are used make sure the caption fits the page:
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The following tokens can be used to in captions and QR codes from Twitter downloads:
{date} date the photo was tweeted on Twitter e.g. 2020/12/28
{time} time the photo was posted on tweeted on Twitter e.g. 22:05:29
{photo}filename of the photo e.g. 162876187264876_87687656.jpg
{photo
_id}

id of the photo e.g. 162876187264876_87687656

{usern
ame}

author's Twitter username e.g. johndoe

{full_n
ame}

author's full name e.g. John Doe

{user_i
d}

author's Twitter user id e.g. 87687656

{captio
n}

Twitter tweet text e.g. Great party! #wedding20150115

{captio
nNoUR
L}

Twitter tweet text with the trailing URL removed

{hasht
ag}

the search hashtag

{twitter
}

1 if this is a Twitter tweet else empty

You can also use the tokens on this page.

The example layout above includes a QR code which can be defined using a fixed URL (e.g. a link to
your website or your client's website) or a dynamically generated URL (e.g. a date based link a photo
gallery on your website or links to display the author's other tweets). Some example URLs are given
below:

URL for QR codes to display the author's other tweets:
https://twitter/{user_id}
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10 Breeze Gallery Uploader

Breeze Gallery Uploader is a tool to automatically upload photos, animated GIFs and MP4 movies
from Breeze photo boot applications to online galleries. It can upload files using HTTPS POST to a
website or an online gallery such as Photobooth Online Galerie (https://www.photobooth-deluxe.de/en/
wordpress-photobooth-galerie-dokumentation/). Alternatively it can upload files directly to galleries in
Hula Gallery (https://www.hula.co/apps/gallery).

The uploader monitors the output folder from the photo booth application and reads the XML summary
file to obtain a list of files and associated meta data to upload. Internet usage is minimized by checking
whether a file is already on the server before uploading the file. Files from a single session can be
grouped so that they are displayed together in the online gallery e.g. if the photo booth takes a series
of photos and creates prints and a GIF or MP4 slideshow the online gallery can display the slideshow,
individual photos and print layout on a single page.

General Settings

Run Breeze Gallery Uploader and select File->Preferences... to display the "Preferences" dialog:

The upper portion of the "Preferences" dialog has settings which are the same whether you are
uploading via HTTPS POST or to Hula Gallery.

Set the "Folder to monitor" to the folder to monitor for new images. In the screenshot above this has
been set up to monitor the Dropbox folder where our Breeze Booth for iPad app saves images. You
can also use tokens such as the {date} for today's date or {eventName} for the event name shared
between our Windows based apps. If you are running a photo booth on a Windows PC using our 
DSLR Remote Pro software you could set the "Folder to monitor" to {documents}
\PhotoboothImages\{dateLess8h}.

Set the stable time to allow time for delays transferring files to the folder to be monitored. These could
be networking delays if the files are being synced via Dropbox or copied from another computer on a
LAN. Breeze Gallery Uploader will wait for the size of new files to be unchanged for the stable time
before uploading them.

The "GIF/MP4 uploads:" dropdown list setting specifies whether to upload GIFs only, MP4s only or
both when both a GIF and a MP4 file is available.

Select "Upload print layout" to upload a copy of the print layout.

Select "Upload individual photos" to upload the individual photos. If the photo booth is set up to save a

https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
https://www.hula.co/apps/gallery
https://breezebooth.co/
http://breezesys.com/DSLRRemotePro
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copy of the processed photos this option will upload the processed photos not the original unmodified
photos from the camera.

Select "Upload slideshow" to upload the animated GIF or MP4 slideshow captured by the photo booth.

Select "Upload XML summary" to upload the photo booth XML summary. The XML summary file
contains detailed information, such as survey data, about the session which can be used by some
gallery software to provide statistics and analytics.

The "Get status before uploading" setting can be used to save network bandwidth by sending a small
status request to the server and only uploading the image file if the image has not already been
uploaded.

The "Verify checksum before uploading" setting checks the MD5 checksum read from the photo booth
XML summary file with the MD5 checksum of the file to be uploaded before uploading the file. This
setting is useful if the files are being transferred to computer running the uploader are delayed due to a
slow network or other issues.
Our Breeze Booth for iPad app and recent versions of our Windows based DSLR Remote Pro photo
booth software save the MD5 in the photo booth XML summary file. Older versions of DSLR Remote
Pro may not save the MD5 checksum. If the MD5 checksum is not available in the XML summary file
the uploader will upload the files using the "Stable time" setting above. 

Uploading using HTTPS POST

The HTTPS POST option can be used to upload images to Photobooth Online Galerie (https://www.
photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/) or any other web based
gallery system that has a suitable script to receive the uploaded files. Please see the technical details
at the bottom of this page for information on writing a script to receive the files.

To use the HTTPS POST option set the "Upload type" to "POST":

https://breezebooth.co/
http://breezesys.com/DSLRRemotePro
https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
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Next set the "POST URL" to the URL of the script used to receive the uploaded files on the web
server.

Set the "POST password" to the password used by the online gallery to provide additional security.

Please note: Photobooth Online Galerie is a subscription based gallery service run by
PHOTOBOOTH DELUXE. Please see their support pages for help and documentation: https://www.
photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/

Uploading to Hula Gallery

Please note: Hula Gallery has been acquired by Darkroom Software who may have made changes to
the way photos are uploaded which may prevent the Gallery Uploader from uploading to their online
gallery system.

Set the "Upload type" to "Hula Gallery" to set up Breeze Gallery Uploader to upload files to Hula
Gallery:

https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
https://www.photobooth-deluxe.de/
https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
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First enter your Hula Gallery API key in the "API Key" field. This can be found be logging into your Hula
Gallery account and going to the account settings and clicking on the "API" section.

Next enter the collection name (aka gallery name) in the "Collection name" field. This field must only
contain letters, numbers, spaces and hyphens. Tokens such as {summaryDate} or {eventName} can
be used in this field.

Enter the collection date in the "Collection date" field. This must be in the form YYYY-MM-DD (e.g.
2019-09-15 for September 15, 2019). Tokens such as {summaryDate}, which reads the date from the
XML summary file, can be used in this field.

Set the optional "Collection URL" field to create a custom URL for accessing a gallery. This must only
contain letters, numbers and hyphens. Tokens such as {eventName} can also be used in this field.
Example: if your Hula Gallery subdomain name is photobooth and the collection URL is set to
gallery2019 the URL of the gallery will be https://photobooth.hulagallery.com/gallery2019
The collection URL should not change for different uploads to the same collection. If a file with a
different collection URL is uploaded to an existing collection the new collection URL is ignored.

The "Image group tag" is used to group images together (e.g. the print layout, the individual photos
and a slideshow GIF) in the gallery pages. Files uploaded with the same tag will be displayed on the
same gallery page. This field must only contain letters and numbers and can use tokens such as {uid}.
The default setting is the {uid} token which extracts the eight character UID from the filenames of files
created using our iPad based and Windows based photo booth software.

Uploading Files
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After setting up the upload method press the "Run" button to start uploading files. Breeze Gallery
Uploader will scan the folder to be monitored and all its subfolders for photo booth XML summary files.
The files will be added to the XML queue until the remain stable (i.e. the file size doesn't change) for
the stable time and then they will be read and the files will be added to the upload queue. When a file
has remained stable for the stable time (and its MD5 checksum matches the value in the XML
summary file if the "Verify checksum before uploading" option is selected) it will be uploaded.

If the "Get status before uploading" option is selected a status request is sent to the server and the file
is only uploaded if it isn't already on the server. If there is an error the file is placed in the upload queue
for another attempt. If it fails 9 times the upload of that file is abandoned.

When in "run mode" Breeze Gallery Uploader will continuously monitor the folder to be monitored for
new files and automatically add them to the XML and upload queues. This means that you can leave it
running while a photo booth is in use and it will automatically upload new photos to the server as they
are taken.

A log showing the date and time is displayed in the main part of the uploader's window. This can be
saved to file for future reference by selecting File->Save log file...

Please note: Breeze Gallery Uploader does not keep a record of uploaded files between sessions. If
the folder to be monitored contains galleries that have already been uploaded they will be scanned by
the uploader each time it is run and any files it finds will be uploaded to the server again. Please use
the "Get status before uploading" option to reduce internet usage if the uploader is setup to monitor
folders of images that have already been uploaded. Alternatively use the {eventName} or date based
tokens to specify the folder to be monitored so that it only scans the current event.

Command Line Options

Breeze Gallery Uploader can also be run using a desktop shortcut or a script with command line
arguments to specify the settings. The following command line arguments can be used:

-a automatically enter run mode at startup
<xml_setting
s_file>

load the settings from an XML settings file

Sample PHP Script
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The PHP script below shows how files sent by the Breeze Gallery Uploading using the HTTPS POST
method can be received on a web site. This script is for illustrative purposes only and comes with no
warranty or support. You are free to use this script or modify it as required, but if you do so you are
responsible for checking that it is secure and meets your requirements.

The script handles two types of request:
1. "get_status" which checks whether a file has already been loaded to the server (and doesn't include

the actual file in the upload). The script responds with the JSON string:
("exists": true, "filename": "<filename>"} if the file exists or ("exists": false, "filename": "<filename>"}
if it does not exist.

2. "upload" which uploads the file to the server. The script returns status code 200 if the upload is
successful or an error code and message if there is an error.

<?php

function logError($msg)
{

file_put_contents('../upload_log.txt', $msg . PHP_EOL, FILE_APPEND | LOCK_EX);
}

function fatalError($code, $msg)
{

// clear the old headers
header_remove();

// set the actual code
http_response_code($code);

// set the header to make sure cache is forced
header("Cache-Control: no-transform,public,max-age=300,s-maxage=900");

header('Content-Type: text/plain; charset=utf-8');
echo $msg;
logError($msg);
exit();

}

// replace this with a more secure password
$password = "photos";

// folder in which to store uploaded images
$destdir = "../gallery_uploads";

$id = $_POST["id"];
$request = $_POST["request"];
$filename = $_POST["filename"];
$chksum = $_POST["md5"];
$key = $_POST["key"];

// check client authentication string is correct
$localKey = "breeze" . $id . $password . $filename . $chksum;
if (sha1($localKey) != $key) {

fatalError(401, "Not authorized $key, " . sha1($localKey) . " id=$id, filename=$filename");
}

if ($request == "get_status")
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{
// check whether file already exists on the server
$destFile = "$destdir/$filename";
$arr = array('exists' => file_exists($destFile), 'filename' => $filename);
fatalError(400, json_encode($arr));

}
else if ($request != "upload")
{

// check whether it is an upload request
fatalError(400, "Invalid request: $request");

}

try {
// Undefined | Multiple Files | $_FILES Corruption Attack
// If this request falls under any of them, treat it invalid.
if (!isset($_FILES['fileToUpload']['error']) || is_array($_FILES['fileToUpload']['error'])) {

fatalError(400, "Invalid parameters");
}

// Check $_FILES['fileToUpload']['error'] value.
switch ($_FILES['fileToUpload']['error']) {
case UPLOAD_ERR_OK:

break;
case UPLOAD_ERR_NO_FILE:

fatalError(400, 'No file sent');
case UPLOAD_ERR_INI_SIZE:
case UPLOAD_ERR_FORM_SIZE:

fatalError(400, 'Exceeded form file size limit');
default:

fatalError(400, 'Unknown error');
}

// Check MIME type
$finfo = new finfo(FILEINFO_MIME_TYPE);
$mimeType = $finfo->file($_FILES['fileToUpload']['tmp_name']);
if (false === array_search(

$mimeType,
array(

'image/jpeg',
'image/gif',
'video/mp4',
'video/quicktime',
'text/xml',

)
)) {

fatalError(400, "Unexpected MIME type: " . $mimeType);
}

$srcFile = $_FILES["fileToUpload"]["tmp_name"];

// check file is JPEG, GIF, MP4 or XML
$fileType = strtolower(pathinfo($filename,PATHINFO_EXTENSION));
if ($fileType != "jpg" && $fileType != "gif"  && $fileType != "mp4" && $fileType != "xml" ) {

fatalError(400, "File type not allowed");
}

// check MD5 checksum matches uploaded file
if (strcasecmp(md5_file($_FILES["fileToUpload"]["tmp_name"]), $chksum) != 0) {
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fatalError(400, "MD5 checksum incorrect");
}

// read filename and dir from $filename and create dir if it doesn't already exist
[ 'basename' => $basename, 'dirname' => $dirname ] = pathinfo($filename);
$destFile = "$destdir/$basename";
if (strlen($dirname) > 0)
{

$dir = "$destdir/$dirname";
if (!file_exists($dir)) {

mkdir($dir, 0777, true);
}
if (file_exists($dir)) {

$destFile = "$dir/$basename";
}

}

// move the uploaded file to the upload folder
if (move_uploaded_file($srcFile, $destFile)) {

header('Content-Type: text/plain; charset=utf-8');
echo "File: $destFile";

} else {
logError("move_uploaded_file($srcFile, $destFile) failed");
fatalError(400, "Error copying file to upload folder: $destFile");

}
} catch (RuntimeException $e) {

fatalError(400, $e->getMessage());
}

?>

11 Automatically uploading photos to SmugMug

The SmugMug uploader automatically uploads JPEG images, animated GIFs and MP4 movie files to
your SmugMug account.
Please note: You need to purchase a subscription to SmugMug before using the SmugMug uploader.
Please visit SmugMug's website for details: www.smugmug.com

Run the SmugMug Uploader by double clicking on the SmugMug Uploader desktop icon:

https://www.smugmug.com/
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The top of the SmugMug Uploader windows summarizes the settings for uploading JPEGs, GIFs and
MP4 files, showing the source folder that is monitored for new files and the destination album where
they will be uploaded to in your SmugMug account. The area in the middle shows status messages
from uploading files.

Click on the "Settings..." button to display the settings dialog:
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Select the "Upload JPEGs" checkbox to enable the uploading of JPEG images and specify the folder it
should monitor for new images in the edit area below. The folder path can use tokens to specify values
that use tokens that are evaluated at run time e.g.the default setting of {documents}
\PhotoboothImages\{year}-{month}-{day}\prints will be give the following when the SmugMug Uploader
is run on July 20, 2017:
C:\users\your_login_name\Documents\PhotoboothImages\2017-07-20\prints

The "Album:" settings specifies the path of the SmugMug album to which the JPEGs will be uploaded.
The vertical bar or pipe character '|' is used separate album names to allow albums within parent
albums to be specified. The Album path can also use tokens e.g. the default setting of {year} Albums|
Photo booth|{year}-{month}-{day} will be give the following when the SmugMug Uploader is run on July
20, 2017:

2017 Albums
Photo booth

2017-07-20

"2017 Albums" is the parent album name created in your SmugMug account and will have a child
album named "Photo booth" which in turn has a child album named "2017-07-20" which will receive the
uploaded JPEG images.

Each uploaded JPEG can have a title which is displayed when viewing thumbnails and an optional
caption. Both the title and the caption can include tokens if required.



Automatically uploading photos to SmugMug 71

© 2022 Breeze Systems Ltd

The settings for animated GIFs and movie files work in a similar way to the JPEG settings.

The SmugMug Uploader can use tokens related to date and time, filenames and event info, but does
not use the shooting data related tokens. Please see the Tokens page for details.

Click on the "Save..." button to save the settings to file. Load the settings from file by clicking on the
"Load..." button.

Logging into your SmugMug account

Click on the "Login..." button to log into your SmugMug account. If you have already logged into
SmugMug it will ask whether you wish to log in using the saved access token:

Click on "Yes" if you wish to use the saved account token or click on "No" if you wish to log in using a
different account. If no previous log in details have been saved, the access token has been canceled
or you clicked on "No" above the login dialog will be displayed:

Click on the "Login to SmugMug" button to open a web browser window to login to your SmugMug
account. Enter your SmugMug username and password to authorize the SmugMug Uploader app and
6-digit PIN similar to the one below will be displayed:
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Enter the PIN in the "SmugMug Login" dialog and click on OK:

The main SmugMug Uploader window will display the logged in status in the title bar and the status
message area and will automatically start scanning the folders to be monitored for images to upload to
SmugMug. It will compare the filename of each file in the folder being monitored with the filenames of
the files in the SmugMug album and only upload files that are not already in the album.
Please note: If the SmugMug album already contains a file with the same filename as a file in the
folder being monitored for images it will not upload the file even if it is a different image. 
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Click on the "Pause" button to pause the upload process. Uploads can be resumed by clicking on the
button again.
Click on the "Settings..." button to change the settings. Uploads will be paused while the settings are
being changed and resumed when the settings dialog is closed.

Click on the "Exit" button to close the SmugMug Uploader. This will save the current settings together
with the SmugMug access token. If you do not wish other users of the computer to be able to run the
SmugMug Uploader using your saved access token you can delete the setting by running the
SmugMug Uploader again and clicking on the "Login..." button to display and then click on "No". Then
click on "Cancel" to close the login dialog and "Exit" to close the SmugMug Uploader and the saved
access token will be deleted.

Command Line Options

The SmugMug Uploader can also be run using a desktop shortcut or a script with command line
arguments to specify the settings. The following command line arguments can be used:

-a automatically login at startup
<xml_setting
s_file>

load the settings from an XML settings file
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12 Automatically uploading images to other photo sharing
sites

Example settings for uploading to Flickr
The simplest example is to email the image to your personal Flickr upload email address leaving the
subject and message fields empty. You can also add a title and tags in the image using the subject line
e.g. to add the title "John and Sue's Wedding" with the tags "photobooth" and the date the subject
would be "John and Sue's Wedding tags: photobooth %d" (the token %d is replaced by the date in the
form YYYYMMDD). A description can be added to the image using the email body text. The email
settings would look something like:

Important: You must leave the "Message (HTML format)" section empty otherwise the email will be
sent with the image embedded not attached and it will not be recognized by Flickr.

Example commands for uploading to Twitter
Twitter doesn't do photos, but if you use a service like twitpic you can upload a photo and send a tweet
with a message and a link to the photo hosted on twitpic. The subject line of the email will form the
tweet sent to twitter together with a link to the photo e.g. "Photobooth shots from John and Sue's
wedding party taken at %H:%M:%S" (the tokens %H, %M and %S are replaced by the time in hours,

http://www.flickr.com
http://www.twitter.com
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minutes and seconds respectively). 

Alternatively you could upload your photos to Flickr and then send a tweet to let people know when a
new photo is available. To do this you need to use a service such as TwitterCounter to tweet by email
and send a second email to Flickr to upload the image. The command called by HotFolder Prints can
only do one thing and so we need to get it to call a batch file in order to send the two emails. We could
call the batch file flickr_and_tweet.bat and use something like this:

echo off
email_image.exe -s%1 -rmyupload12addr@photos.flickr.com -ojohn@doe.com %3
email_image.exe -s%2 -r6gthg-jhgjhgk@twittermail.com -ojohn@doe.com

The Hotfolder Prints command could be something like this:
flickr_and_tweet.bat "John and Sue's Wedding tags: photobooth %d" "%H:%M:%S
posted another great photo from John and Sue's wedding: http://www.flickr.
com/photos/myname" {pathname}

http://twittercounter.com
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Example settings for uploading to DropBox

DropBox provides a very simple way to upload photos and view them in a gallery. All you need to do is
copy the photos to the appropriate DropBox folder on your PC and they will be automatically uploaded
to the DropBox website. If no internet connection is available during the event DropBox will
automatically upload the photos when an internet connection is available. The photos can be copied to
the DropBox folder on your PC using the "Copy JPEG to output folder" option e.g.

You could also email the user a copy of the photo and a link to the gallery using email settings like the
ones below. Users can enter their email address using the touchscreen keyboard option in our photo
booth software and Hotfolder Prints will send an email with the photo attached together with a link to
the DropBox photo gallery.

http://www.dropbox.com
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13 Tokens

The following tokens are available for using in the caption text. The values are read from the EXIF
shooting data in the first image used in the print layout.

Date and time tokens

%a Abbreviated weekday name e.g. Fri

%A Full weekday name e.g. Friday

%b Abbreviated month name e.g. Jun

%B Full month name e.g. June

%d
Date in the form YYMMDD (equivalent to %y%m%
D)

e.g. 170611 for
June 11, 2017

%D or {day} Day of the month (01 to 31)  

%H Hour (00 to 23)  
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%I Hour (01 to 12)  

%j Day of the year (001 to 366)  

%l Long date/time representation of locale
e.g. Monday, July
25, 2017 19:03:47

%L Long date representation for locale
e.g. Monday, June
25, 2017

%m or {month} Month (01 to 12) e.g. 06 for June

%M Minutes (00 to 59)  

%p am/pm indicator e.g. PM

%S Seconds (00 to 59)  

%t
Time in the form HHMMSS (equivalent to %H%M%
S)

 

%W Week number (00 to 53)  

%x Date representation for locale
e.g. 06/10/17 for
June 10, 2017

%X Time representation for locale e.g. 14:39:29

%y Year without century e.g. 16

%Y or {year} Year with century e.g. 2017

%z Time zone name
e.g. GMT Standard
Time

%Z Time zone offset wrt UTC
e.g. +0100 for
GMT during DST

{yearNow} Year 'now' in the form YYYY. e.g. 2017

{monthNow} Month 'now' (01 to 12) e.g. 07 for July

{dayNow} Day 'now' (01 to 31) e.g. 23 

{dateNow} or {date} Date 'now' in the form YYYY-MM-DD e.g. 2020-11-28

{yearLess8h}
Year 'now - 8 hours' in the form YYYY.
The 8 hour offset is to allow date tokens to remain
the same for events which continue after midnight

e.g. 2017

{monthLess8h} Month 'now - 8 hours' (01 to 12) e.g. 07 for July

{dayLess8h} Day 'now - 8 hours' (01 to 31) e.g. 23

{dateLess8h}
Year, month, day less 8 hours in the form YYYY-
MM-DD

e.g. 2017-07-23

Shooting data tokens

%c Camera serial number (Canon EOS cameras only)  

%C Canon EOS-1D/1DS style camera serial number  

%e File extension (without the '.')
e.g. JPG for
IMG_4567.JPG

%i ISO value read from the shooting data  
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%o Image filename without extension e.g. IMG_4567

%O Owner string (Canon cameras only)  

%T
Camera model name starting from the first word
containing digits

e.g. 80D for
Canon EOS 80D

%T1 Same as %T, but '-' are treated as spaces
e.g. 1DX for
Canon EOS-1DX

%T2 Full camera model name
e.g. Canon EOS
80D

%T3 First word of camera model name containing digits

e.g. DC4800 for
KODAK DC4800
ZOOM DIGITAL
CAMERA

%T4 Same as %T3, but '-' are treated as spaces  

%T5 Last word of camera model name containing digits
e.g. 80D for
Canon EOS 80D

%T6 Same as %T5, but '-' are treated as spaces
e.g. 1DX for
Canon EOS-1DX

%v
Camera model name starting from the first word
containing digits (same as %T)

 

%V Full camera model name (same as %T2)  

{comment} The contents of the EXIF UserComment field

Tokens for modifying strings

The tokens below can be used to modify tokens or strings:

Token Description Example

{left,n,str} Extracts the first n characters from str
(which can be a string or token). 

{left,4,{filename}} for D:\Photos\image1.jpg
will give: image

{mid,n,m,st
r}

Extracts m characters starting from the
n'th character from str (which can be a
string or token). 

{mid,1,3,{filename}} for D:\Photos\image1.
jpg will give: mag
{mid,3,,{filename}} for D:\Photos\image1.jpg
will give: ge1

{right,n,str} Extracts the last n characters from str
(which can be a string or token). 

{right,2,{filename}} for D:\Photos\image1.jpg
will give: e1

{field,n,str} Extracts the nth field from str. Fields are
separated by space, period, hyphen, slash,
backslash or underscore characters

{field,2,{filename}} for D:\Photos\IMG_0001.
jpg will give: IMG

{field2,n,ch,
str}

Extracts the nth field from str using the
character ch as the field separator

{field2,2,-,one-two-three} will give: two

{first,str} Extracts the first word from str (which can
be a string or token).

{first,%L} for an image taken Monday,
January 17, 2015 will give: Monday

{last,str} Extracts the last word from str (which can
be a string or token).

{last,%L} for an image taken Monday,
January 17, 2015 will give: 2015

{upper,str} Converts str to upper case {upper,%B} for a photo taken in June gives:
JUNE
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{lower,str} Converts str to lower case {lower,%B} for a photo taken in June gives:
june

{capitalize,s
tr}

Converts str to lower case and capitalizes
the first letter

{capitalize,john} gives John

{default,str1
,str2}

Returns str1 unless it is an empty string in
which case it returns str2 (str1 and str2
can be strings or tokens

{default,1,2} returns 1
{default,,2} returns 2

{if,test,str1,
str2}

Returns str1 if test contains any text
except 0 else returns str2 (test, str1 and
str2 can be strings or tokens)

{if,1,2,3} returns 2
{if,0,2,3} returns 3
{if,,2,3} returns 3

{compare,st
r1,str2}

Returns 1 if str1 is the same as str2 else
returns an empty string

{compare,photo,photo} returns 1,
{compare,photo,image} returns empty string

{contains,st
r1,str2}

Returns 1 if str1 contains str2 else returns
an empty string

{contains,photo,to} returns 1,
{contains,photo,camera} returns empty
string

{random,n,
m}

Returns a random number in the range n
to m. A new random number is generated
each time the ready screen is displayed in
photo booth mode

{random,1,10} returns a random number
between 1 and 10

{urlencode,
str}

Encodes str so that it can be used as a
parameter in a URL e.g. when providing a
URL for a microsite

https://yoursite.com/viewer.php?id={urlenco
de,my name} gives
https://yoursite.com/viewer.php?id=my%20n
ame

Event info tokens

Hotfolder Prints, Breeze Viewer, the SmugMug uploader and the Twitter hashtag monitors can all use
the event info shared by other Breeze Systems' apps (e.g. DSLR Remote Pro v3.7.2 onwards) that
save the information in the Windows registry under the registry key
HKEY_CURRENT_USER\Software\BreezeSystems\Event Info

{eventName} The event name read from HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventName

{eventString1} Event string 1 read from HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString1

{eventString2} Event string 2 read from HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString2

{eventString3} Event string 3 read from HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString3

{eventString4} Event string 4 read from HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString4

{eventString5} Event string 5 read from HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString5

Other tokens

{filename} Filename (including folder) of the saved print layout JPEG image. If the pathname
contains spaces this will be automatically converted into a Windows short pathname
when used in the command run after saving the JPEG copy of the output.

{filenameDir} Directory path of the saved print layout JPEG image e.g. If the JPEG image of the
saved print layout is C:\Photobooth\2013-10-16\IMG_0001.JPG {filenameDir}
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evaluates to C:\Photobooth\2013-10-16\
{filenameNoEx
t}

Filename (without folder or file extension) of the saved print layout JPEG image e.g. If
the JPEG image of the saved print layout is C:\Photobooth\2013-10-16\IMG_0001.JPG
{filenameNoExt} evaluates to IMG_0001

{srcPhotoPath
name<n>}

The full pathname (drive, folder, filename and file extension) of the the nth source
image e.g. {srcPhotoPathname1} gives the full pathname of the first source photo

{srcPhotoFilen
ame<n>}

The filename (filename and file extension) of the the nth source image e.g.
{srcPhotoFilename2} gives the filename (including file extension) of the second source
photo

{srcPhotoFilen
ameNoExt<n>
}

The filename (without file extension) of the the nth source image e.g.
{srcPhotoFilenameNoExt1} gives the filename of the first source photo

{srcPhotoSubf
older<n>}

The subfolder of the nth source image e.g. gives Hashtag if the pathname of the
source image is C:\Twitter\Hashtag\Photo.JPG

{user_data} Information (e.g. email address) entered by users using the touchscreen keyboard
option in Breeze Systems' photobooth software

{user2_data}
to
{user9_data}

Additional information (e.g. name, phone number) entered by users using the
touchscreen keyboard option in Breeze Systems' photobooth software

{user_data_e
mails}

Special token for use with the command run after saving the JPEG copy of the output.
The {user_data} tokens are scanned for correctly formed email addresses (e.g.
name@domain.com) and the command is called for each email address

{text1} to
{text5}

Text read from the Windows registry when printing. This is useful if another app needs
to modify caption text used by Hotfolder Prints while it is running.
Example registry key: e.g.
HKEY_CURRENT_USER\Software\BreezeSystems\HotfolderPrints\100\{text1}

{output} The value of the <output> tag read from the photobooth summary XML file written by
Breeze Systems' photobooth software

{uid} Unique id in the form ABC12345 updated before processing each set of photos. It can
be used in captions and to specify the output filename. The id is guaranteed not to
repeat within 72 hours and is very unlikely to repeat within 10 years.

{uid2} Alternative unique id in the form ABCDE123 updated before processing each set of
photos. It can be used in captions to specify the output filename. The id is guaranteed
not to repeat within 776 days and computers processing photos at exactly the same
time have a 1 in 216,000,000 chance of generating the same id.

{summaryDate
}

The date in the form YYYY-MM-DD read from the XML summary file. Please note that
this token is only used by Breeze Gallery Uploader

14 How to create PNG images using Photoshop

Photoshop
First create a new image with a transparent background. Then create a mask by clicking on the "Add
layer mask" in the layers palette.

Next add the graphics such as text overlays and picture frames to the image layer and use the layer
mask to control the transparency. In the layer mask white represents opaque, black represents fully
transparent and values between white and black represent increasing transparency.

Save a copy of the image as a PSD file for future reference and then save the image as a PNG file
named overlay.png.

An existing PNG image containing trnasparency information in the alpha channel can be edited in
Photoshop by loading it into Photoshop. The layer mask containing the transparency information can
be recreated by selecting Layer->Layer Mask->From Transparency.
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Photoshop Elements
First create a new image with a transparent background. Next add the graphics such as text overlays
and picture frames and use the opacity slider for the layers to control opacity. To get a simple fade
effect, you can also use the gradient tool. Once you’re happy with your image, save a copy as a PSD
file for future reference and then save the image as a PNG file named overlay.png.

15 Release History

15 September 2022: v1.8.3
· Added the ability to process video files by extracting a still image from the video
· Fixed an issue with creating albums when using the SmugMug Uploader

12 July 2021: v1.8.2
· Added optional background/overlay filename suffix to provide more flexible selection of backgrounds

and overlays
· Added the option to rotate the output to match the EXIF orientation of the first photo
· Added {field2,n,sep,str} token which allows the field separator to be specified
· Added {contains,str1,str2} token to test whether str1 contains str2
· Fixed an issue with the print layout editor crashing if a previously selected printer is no longer

available
· BreezeViewer now supports PNGs as well as JPEGs and animated GIFs
· Removed the Instagram Hashtag Monitor which is no longer supported due to changes made by

Instagram

4 December 2019: v1.8.1
· Added command line options to auto run and to load XML settings from file when running Breeze

Gallery Uploader
· Added command line options to auto login and to load XML settings from file when running the

SmugMug Uploader
· Breeze Viewer now supports the display of adverts in mosaic modes when displaying animated GIFs
· Improved error reporting if a hashtag is not found when running the Hashtag Monitor 
· Fixed an issue uploading MP4 videos using Breeze Gallery Uploader
· Fixed an issue when auto copies printing when copies set to 0 and output set to print only in

Hotfolder Prints

9 September 2019: v1.8
· Added new Breeze Gallery Uploader for automatically uploading photos, GIFs and MP4s to online

galleries
· PNG logos and JPEG images can now be added to print layouts
· Improved handling of login access tokens in SmugMug uploader and added the option to save the

settings to file
· Added {captionNoURL} token for extracting Twitter captions without the trailing URL

10 January 2018: v1.7
· Added support for event name and event string tokens shared with other event software from

Breeze Systems
· Additional error checking of hashtags in the Instagram Hashtag Monitor
· Updated the Instagram Hashtag monitor to work with the latest updates made by Instagram
· More accurate playback speed of animated GIFs in Breeze Viewer
· Fixed a problem with photos being auto-rotated using the orientation read from the EXIF shooting

data
· Added a workaround for a Windows bug that was preventing the {uid} and {uid2} tokens from
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generating random values

24 July 2017: v1.6
· Added the ability to process PNG images as well as JPEG images in Hotfolder Prints
· BreezeViewer now supports animated GIFs and adds "mosaic with flip" slideshow transition
· Updated Instagram Hashtag Monitor following changes to the way Instagram works
· Added SmugMug upload utility

27 April 2016: v1.5.5
· Instagram Hashtag Monitor now downloads the high resolution copies of photos if available
· Fixed a problem with loading saved settings via the command line when running Hotfolder Prints
· Updated Instagram Hashtag Monitor following recent changes in the way Instagram works
· Fixed a problem with timestamps using Twitter Hashtag Monitor in different time zones

30 September 2015: v1.5.4
· Added Twitter Hashtag Monitor for downloading photos from Twitter
· The "Crop image to fit photo area" option now applies to the custom layout. Unchecking this allows a

photo to be resized to fit a bounding box instead of being cropped to fit.
· Now supports up to 12 captions in the print layout, options to change the caption display order and

the option to right justify the caption text

17 August 2015: v1.5.3
· Added the ability to load different overlay.png and background.jpg images according to the

orientation of the first photo
· Minor changes to the way progress information is displayed in Hashtag Monitor
· Added workaround for Instagram "Unsupported size" bug
· Fixed a problem which prevented Hotfolder Prints from monitoring folders with non-ASCII

pathnames
· Fixed a problem with Hashtag Monitor when setting the "Max age in hours" to a non-zero value
· Fixed a problem with the stable time setting in Breeze Viewer

7 July 2015: v1.5.2
· Added "Mosaic with zoom + bg fade" slideshow transition to BreezeViewer
· Re-written Hashtag Monitor so that login the screen can handle Captcha codes
· Added {field,n,str} token to make it easier to extract values from strings
· Fixed a problem with the "Match filename" option not working after adding unicode support in v1.5

19 February 2015: v1.5.1
· Fixed a problem with caption font sizes when using a custom output size in Hotfolder Prints
· Fixed a problem with reading the hotfolder location when launching Hotfolder Prints with an XML

settings file
· Added the option to save the Instagram username and password when running Hashtag Monitor
· Added configurable polling interval option for Hashtag Monitor (accessed via Configure.exe utility)
· Added desktop shortcut for Hashtag Monitor for easier launching
· BreezeViewer now accepts tokens for the date when specifying the folder to monitor

29 January 2015: v1.5
· New Instagram hashtag monitor for downloading Instagram photos with a given hashtag
· Added optional color management when printing
· Added interactive editor for print layouts
· Added the importing and exporting of photobooth print layouts
· Added the ability to print QR codes on prints
· Added unicode support for handling characters in most languages
· Added the option to leave a space between images when using the mosaic layout option in
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BreezeViewer
· Added captions in the mosaic transitions in BreezeViewer
· Added mosaic zoom transition to BreezeViewer
· Added the option to crop photos before displaying them in BreezeViewer
· Added a user definable background color and an optional background image for the slideshow in

BreezeViewer

18 October 2013: v1.4.4
· Added the ability to email photos using HTML formatting
· Added the option to scan subfolders for images to the Breeze Viewer slideshow utility

19 April 2013: v1.4.3
· Added the option to wait for the XML file and to read the filenames of the images from the XML file
· Added auto color/B&W option which reads the color/B&W mode from the XML file
· Added the ability to send emails to multiple email addresses read from the XML file by using the

{user_data_emails} token
· Added the ability to specify the caption text, font, color and placement to BreezeViewer slideshow

utility
· Added "mosaic", "mosaic with fade" and "mosaic with dissolve" slideshow transitions to

BreezeViewer slideshow utility
· "None" and "mosaic" slideshow transitions in BreezeViewer optimized to run faster on graphics

cards without graphics acceleration
· Fixed a problem which could cause the folder being monitored changing after 60 secs when loading

settings from the command line

10 December 2012: v1.4.2
· Added an option to wait for the XML file, containing data such as the user's email address, to be

written before processing images
· Fixed a problem with email_image.exe displaying a timed error message when there isn't an internet

connection

9 November 2012: v1.4.1
· Added an option to automatically create the folder being monitored if it doesn't already exist
· Added optional naming of the JPEG copy of the printed output by using tokens in the filename prefix
· Added notes about automatically uploading images to Facebook and photo sharing sites using

DropBox/Google Drive/Box and IFTTT

8 June 2012: v1.4
· Added automatic print copies option which reads the number of copies to print from the XML

summary file written by Breeze Systems' photobooth software
· Now has the option to save the current printer settings when saving the settings to file and to restore

them when the settings are loaded from file
· Added information about automatically uploading images to Facebook and photo sharing sites using

DropBox/Google Drive/Box and WappWolf
· email_image.exe no longer displays a timed error message dialog if there is no internet connection

29 February 2012: v1.3
· Now includes the Breeze Viewer slideshow utility
· Log email addresses option now also keeps a separate log of failed emails to make it easier to

resend them later
· Added an option to copy JPEG output to a separate folder
· Added more detailed help on how to upload photos to Facebook and other social networking sites
· JPEG copy subfolder now accepts absolute pathnames
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27 September 2011: v1.2.3
· Added an option in email_image.exe to save email addresses to a CSV log file
· Fixed a problem emailing images when the image filename or folder contains spaces
· Fixed a problem emailing images when the number of retries was set to none

11 August 2011: v1.2.2
· Fixed a problem reading <user2_data> to <user9_data> tags from the XML summary file written by

our photo booth software
· Now doesn't run the optional command if it contains {user_data} tokens which aren't present in the

XML summary file (this prevents an error window being displayed when users choose not to email
images in the photo booth software).

· Added the ability to use date based tokens when specifying the folder to be monitored. The folder
path is checked every 60 seconds and updated if necessary.

12 May 2011: v1.2.1
· Now reads multiple user data fields (e.g. names and email addresses) from XML files written by

Breeze Systems' photobooth software when using the touchscreen keyboard option
· Rewritten the email_image.exe utility to run as a Windows app to avoid having a Command Prompt

window popping up when it is run. The email_image.exe utility now has a debug mode, the option to
retry if sending the email fails and a send test email button to help with setting it up.

21 March 2011: v1.2
· Added the ability to read user data (e.g. email addresses) from XML files written by Breeze Systems'

photobooth software when using the touchscreen keyboard option
· The filename prefix and subfolder where JPEG copies of layouts are saved is now user definable
· Regular expressions may be used to control which images added to the folder being monitored are

processed

10 December 2010: v1.1.1
· Now appends a number to the filenames of saved JPEG layouts to avoid overwriting existing files
· email_image.exe command line email utility now has the option to specify the port number of the

email server and to use SSL STARTTLS to send secure emails
· Now includes an email settings dialog to help setup the command line for emailing images

1 October 2010: v1.1
· Added the ability to specify a custom page size when the output setting is "JPEG copy only"
· Added an optional command line to run on the JPEG print layout e.g. to allow images to be

automatically uploaded to photo sharing and social network sites
· Now automatically loads settings from a file if the file is dragged and dropped on the Hotfolder Prints

desktop icon
· Now detects images that are added to the folder using a different file extension (e.g. .tmp) and then

later renamed to have a .jpg file extension

9 July 2010: v1.0.1
· Added optional delay before processing images
· Added option to pause/resume printing
· Improved the user interface so that controls are no longer disabled during printing
· Added keyboard shortcuts for selecting B&W/color and the number of copies to print

15 June 2010: v1.0
· First public release
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